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Important Notice

COPYRIGHT
The material in this document is copyright to Fairlight ESP Pty Ltd., and may not be
quoted or reproduced in any form without written permission from the company.

Fairlight is a trademark of Fairlight ESP Pty Ltd. All other trademarks are the property
of their respective owners.

Plug-In parameter descriptions are included with kind permission of CreamWare
GmbH.

LIMITED WARRANTY POLICY
All the software and hardware provided with, or purchased especially for, Fairlight prod-
ucts has been tested for functionality. Fairlight ESP Pty Ltd. will make its best efforts to
correct reported defects for future releases subject to technical practicabilities. Fairlight
ESP will also replace any defective media on which software has been delivered provided
that the item to be replaced is returned to the dealer who supported the product within
90 days of purchase.

Fairlight ESP Pty Ltd. makes no warranty or representation either expressed or implied
with respect to the system's performance or fitness for a particular purpose.

In no event will Fairlight ESP Pty Ltd. be liable for direct or indirect damages arising
from any defect in the product or its documentation. Further, Fairlight ESP Pty Ltd. will
not accept any liability for any programs, sounds, audio recording or sequences stored in
or used with Fairlight products, including the cost of recovery of such data.

Product features and specifications are subject to change without notice. Fairlight ESP
reserves the right to change any part of this document without notice.

The warranties, remedies and disclaimers above are exclusive and take precedence over
all others, oral or written, express or implied, to the extent permitted by law in the geo-
graphical area of the product's use. No employee of Fairlight ESP, agent, distributor or
employee of an agent or distributor is authorized to offer any variation from this policy.

Copyright © 2003
Fairlight ESP Pty Ltd.,
Unit 2, 1 Skyline Place,
French's Forest, NSW 2086,
AUSTRALIA.
Telephone +61 2 8897 9999
Fax +61 2 8897 9900
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Chapter 1 -  Introduction

INTRODUCTION
Fairlight Plug-Ins Manager 5 brings the flexibility of third-party plug-ins to the
DREAM family of mixing and editing systems. Plug-Ins Manager 5 is available
as an external Fairlight System Services Module application, or as an integrated
component of the DREAM Station or Console.

Plug-Ins Manager 5 offers support for a wide range of high performance real-
time plug-ins running on the dedicated Plug-Ins Manager, floating-point,
DSP card. The Plug-Ins Manager DSP card may be installed in the System
Services Module or directly within the DREAM Station or Console.

Plug-Ins Manager is seamlessly integrated into the DREAM mixer environ-
ment. Plug-ins may be selected and patched into feeds or buses to be added to
the mix in real-time or recorded to disk. Plug-ins parameters may be mapped
to and controlled from the switches pots and faders on the DREAM control
surface.

ABOUT THIS MANUAL
This manual provides all the information necessary to install and use Plug-Ins
Manager 5.

Follow the steps in the “Installation” chapter to successfully install and test the
Plug-Ins Manager system on either a Fairlight System Services Module or
within the DREAM Station or Console.

Read the “Using Plug-Ins” chapter for complete instructions on applying plug-
ins in your mixing session.

See the online version of this document included on your Plug-Ins Manager
CDROM for complete instructions on using all the standard plug-ins supplied
with the system. Click on the Start menu and select Programs>Fair-
light>Docs>Plug-In Manager Manual.

Check the Table of Contents or Index to quickly find the specific information
you need. When viewing this document on-screen, click on the hyperlinked
cross references to navigate through the document.
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Chapter 2 -  Instal lat ion

INTRODUCTION
Plug-Ins Manager 5 comprises the following components:

• Plug-Ins Manager DSP card (15DSP or 6DSP version)
• Plug-Ins Digital Audio Interface Board 
• Plug-Ins Manager 5 Software
• Optional Station/Console Mounting Kit

PIM 5 Requires DREAM V2.0
You must have successfully completed an upgrade to DREAM Software ver-
sion 2.0 prior to installing Plug-Ins Manager 5.0. Check the V2.0 release notes
for upgrade instructions.

Installation Summary
The installation procedure includes the following steps, summarised below,
which are detailed in this chapter:

1. Install drivers for the Fairlight AIB USB device.
2. Install Plug-Ins Manager hardware in either the SSM, Station or DREAM 

Console.
3. Install drivers for the plug-ins DSP card.
4. Install the Scope Fusion Platform Software.
5. Install Plug-Ins Manager 5 Software on both Station or Console and 

SSM, if used.
6. Place a short-cut to Plug-Ins Manager in your start-up directory.
7. Edit System_Variables.txt to specify physical I/O for plug-ins.
8. Use the DREAMStart Setup page to configure the Fairlight Mixing Con-

sole application.
9. Edit the FlexiSurface.txt file to specify which physical controls will be 

mapped to the plug-in parameters.
PIM 5 REQUIRES DREAM V2.0
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CD Contents
The CD contains the following files and directories:

• Drivers  - directory containing AIB USB drivers, included in case you have
problems using the automatic setup file.

• SFP - directory containing the CreamWare Scope Fusion Platform Instal-
lation files.

• SetupPIMDrivers-####.exe - the AIB USB driver setup file.

• SetupMSAT-####.exe - Fairlight Monitoring System and Automated
Testing application included to assist in troubleshooting and mapping new
plug-ins.

• SetupSFP-####.bat - Scope Fusion Platform setup file.

• SetupAcrobatReader-####.exe - Adobe Acrobat Reader setup file for
viewing the documentation.

• SetupPIMDocs-####.exe - Plug-Ins Manager User Manual setup file.

• SetupPIM-####.exe - Plug-Ins Manager Setup file.
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ADMINISTRATOR LOG-ON
Make sure you are logged on as Administrator before performing any instal-
lation tasks. Administrator is the default user for all DREAM systems. If no
users have been set up on your system, skip this section.

Step 1 If installing the plug-ins hardware in the Station or DREAM 
Console. Quit FMC, if necessary, by holding down the Shift key 
and pressing the Pause/Break key and click on the Exit but-
ton on the DREAM Start splash screen if currently running.

Step 2 Click on the Start button then click Shut Down.

Step 3 Click the drop-down list and examine the entry that reads 
Log off .... If the name is Administrator, click the Cancel 
button, you are already logged on as administrator. 

If you are logged on with another log-on name, select the Log 
off ... item and click OK.

Step 4 When the log-on window is displayed, hold down the Ctrl, Alt 
and Del keys as instructed.

Step 5 When the username and password window is displayed, enter 
Administrator as the username. The default password is 
dream. Consult you system administrator for the correct pass-
word and domain settings.

Step 6 Click OK to log on to the system.

USB DRIVER INSTALLATION
Installing the Fairlight AIB USB driver before installing the hardware simpli-
fies the installation process. The USB driver must be installed in the device in
which the plug-ins hardware will be installed, either a Fairlight System Services
Module (SSM), or Station or DREAM Console.

Step 1 If installing the plug-ins hardware in the Station or DREAM 
Console. Quit FMC, if necessary, by holding down the Shift key 
and pressing the Pause/Break key then type q y. Click on the 
Exit button on the DREAM Start splash screen if currently run-
ning.
CD CONTENTS
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Step 2 Insert the PIM5 CD into the CDROM drive. Click on My 
Computer on the Windows desktop. 

Step 3 Navigate to the CDROM and double click on the SetupPIM-
Drivers file The PIM Driver Installer will run displaying the PIM 
installation Welcome screen.

Step 4 Click Next, then click Next again to start copying the files.

Step 5 Click the Finish button to quit the installer when finished.

The system will now automatically identify the AIB USB device when installed
and load the appropriate drivers.

HARDWARE INSTALLATION
The Plug-Ins Manager hardware may be installed in either a Fairlight System
Services Module, or directly within the Station or DREAM Console. To install
the Plug-Ins Manager in a Station or DREAM Console you will require the
optional Station/Console Plug-Ins installation kit.

Read the sections below then move on to the relevant hardware installation sec-
tion.

Tools Required
• #1 Pozidrive screwdriver
• #2 Pozidrive screwdriver
• 5mm nut driver
HARDWARE INSTALLATION
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Equipment Supplied

8PIM-15DSP Plug-Ins Kit

EQUIPMENT 
SUPPLIED

PART
NUMBER

QTY
CHECK 

LIST

PIM Installation Manual DSSM004-B 1

PIM Software CD 
Including User Manual

7PIMV5.0 1

Registration Key Card 1

AIB USB/DC Cable Assembly APIM102-D 1

Plug-Ins/AIB Audio Bus Cable APIM201-A 1

MIX-AIB AES Audio Interface 
Card c/w CPU card

BMIX042A-A 1

Fairlight 15 DSP Plug-Ins Card GEC8438 1

D connector screw lock Kit FSM8260 1
EQUIPMENT SUPPLIED
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8PIM-6DSP Plug-Ins Kit

EQUIPMENT 
SUPPLIED

PART
NUMBER

QTY
CHECK 

LIST

PIM Installation Manual DSSM004-B 1

PIM Software CD 
Including User Manual

7PIMV5.0 1

Registration Key Card 1

AIB USB/DC Cable Assembly APIM102-D 1

Plug-Ins/AIB Audio Bus Cable APIM201-A 1

MIX-AIB AES Audio Interface 
Card c/w CPU card

BMIX042A-A 1

Fairlight 6 DSP Plug-Ins Card GEC8427 1

D connector screw lock Kit FSM8260 1
HARDWARE INSTALLATION
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1PIM-INST Station/Console PIM Mounting Kit

EQUIPMENT 
SUPPLIED

PART
NUMBER

QTY
CHECK 

LIST

AIB-SBO USB/DC
Cable Assembly

ABE1205-A 1

PIM Mounting Bracket MBE1005-B 1

PCI Rear Support Bracket MBE1006-C 1

PCI Riser Card BMIX155A-A 1

Mounting Screw Kit including:
7 x M3x6mm pozi-drive screws
5 x M4x10mm pozi-drive screws
2 x M3x8mm nylon standoff
2 x M3 nylon nut/washers
2 x M3x12mm male/female hex 
spacers

1

128Mb 168 Pin PC133 RAM SMM6799 1
EQUIPMENT SUPPLIED
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Static Precautions
Do not open or remove components from your system unless specifically
instructed to do so. Please take note that all Fairlight manufactured electronic
modules are static sensitive and should be handled under anti-static conditions.
When working on a system always ensure that you have an anti-static lead con-
nected.

Never work on the system while powered up unless you are authorized by Fair-
light to do so. As a matter of practice always touch the external chassis of the
system before opening the unit. If cards are not handled under anti-static pro-
cedures your machine may sustain damage which could either cause a complete
failure or may cause intermittent crashes and subsequent system failure.

When handling cards please ensure that they are placed in anti-static bags when
not in the system. For shipment purposes electronic modules should be placed
in an anti-static bag and then suitably surrounded with loose packaging mate-
rials in a solid card board box. Cards shipped to Fairlight without the correct
anti-static packaging will have their warranty voided. If you have any enquiries
on this matter please feel free to contact your local Fairlight office or distrib-
utor. 

Unpacking
Check the contents of your plug-ins kit against the list above and make a note
of any omissions.

SSM INSTALLATION
Step 1 Power down the SSM and remove the top cover.

Step 2 To mount the AIB card hardware. Insert the 50-pin D connector 
through the cut-out in the rear panel of the SSM. Attach the con-
nector with the two D connector screwlock fittings supplied. Use 
a 5mm nut driver or small adjustable spanner to tighten the fit-
tings.

Step 3 Install the DSP Card card into the first available PCI slot. Secure 
the card with the mounting screw removed from the SSM blank-
ing plate.
SSM INSTALLATION
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Step 4 Connect the AIB USB/Power cable (APIM102-D). Connect the 
DC connector to a free power supply DC connector. Connect the 
USB header to the motherboard USB2 connector as shown below 
(note that connections may be different on some motherboards):

PCI Slot 1
DSP Card 

USB2
UNPACKING
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Figure 1: SSM Motherboard Connectors

Figure 2: USB Connection Detail (may differ on some motherboards)
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SSM INSTALLATION
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Step 5 Connect the DSP-AIB Audio Bus Cable. Note the orientation of 
the cable as shown below.

Figure 3: SSM Cable Connections

Step 6 Connect a 50-pin AES I/O cable from the AIB to a spare digital 
I/O connector on the QDC engine. See “Digital I/O Connector” 
on page 6-2 for connector pin-out.

Step 7 Re-attach the SSM top cover.

Step 8 Plug-Ins Manager communicates with the Station or console via 
TCP/IP. Connect the SSM via a 100BaseT ethernet hub to the 
Station or Console and QDC engine. See “Network Settings” on 
page 2-30 for configuration details.

Now move to “Software Installation” on page 2-24.

of card. 
Red wire to front

Attach cable to
front connector.

DSP Card

DC power connection

FRONT

USB/DC connector Audio bus connector
UNPACKING
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STATION INSTALLATION 
Step 1 Power down the Station.

Step 2 Remove the top panel of the Station by first removing the four 
M4 retaining screws at the front and the three retaining screws at 
the rear just below the top panel.

Step 3 Carefully lift off the top panel. Note that the panel is connected 
to the base by two internal cables.

Step 4 Disconnect the trackball cable connection from the motherboard 
and the USB/power cable connection from the top panel PCB.

Carefully place the top panel in a safe location. Rest the panel on 
its edge. UNDER NO CIRCUMSTANCES SHOULD THE 
ROTARY ENCODERS REST AGAINST ANY SURFACE.

Step 5 Remove the blanking panel from the 50-pin D-connector cut-out 
on the rear panel of the Station by unscrewing the two M3 
screws.

Step 6 Attach the nylon spacer to the PCI rear support bracket with an 
M3 screw. 

Step 7 Attach the PCI rear support bracket to the threaded standoffs 
next to the CDROM drive with two M4 screws.

M4 Mounting Screws

Nylon Spacer
STATION INSTALLATION
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Step 8 On a flat surface, assemble the mounting bracket, PCI riser card 
and DSP card as shown in the picture below. Insert the two M3 
screws as shown. 

Figure 4: Bracket/PCI Riser/DSP Card Assembly

Step 9 Carefully lift the assembly and insert it into the Station as indi-
cated. Lift the keyboard cable to allow the mounting bracket to 
line up with the mounting hole in the rear panel. Make sure the 
mounting bracket is aligned with the two standoffs on the Station 
base and that the bracket is not obstructed by any of the existing 
cables. Adjust the cables if necessary.

Step 10 Align the hole in the end of the DSP card with the nylon spacer 
on the PCI rear support bracket. Attach the DSP card with  one 
M3 nylon nut.

M3 Screw

M3 Screw PCI Riser Card
UNPACKING
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Step 11 Carefully insert the PCI riser card into the PCI slot in the moth-
erboard and press down firmly until the card is fully inserted in 
the PCI edge connector.

Figure 5: Bracket/PCI Riser/DSP Card Installation

Step 12  Secure the bracket by inserting one M4 retaining screw through 
the Station rear panel.

Insert the remaining two M4 retaining screws through the top of 
the bracket into the threaded standoffs on the Station base plate.

Step 13 Attach the AIB card to the mounting bracket by inserting the 50-
pin connector through the rear panel cut-out. Attach the AIB 
card to the bracket with the two M3 screws provided.

Finally, insert the two D connector screw-lock posts through the 
rear panel of the Station into the 50-pin D connector. Tighten 

M4 Bracket Screws

SBO USB/DC Connector

PCI Edge Connector

Keyboard Cable

RAM SIMM
STATION INSTALLATION
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the screw-lock posts with a 5mm nut driver or small adjustable 
spanner. 

Figure 6: Mounting Detail - Screws at Rear of Station

Step 14 Install the USB/DC cable (ABE1205-A) from the AIB card to the 
spare connector on the SBO card as shown.

M4 Bracket retaining screw

AIB D connector screw lock posts
UNPACKING
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Step 15 Install the audio bus cable (APIM201-A), note the orientation of 
the cable as shown.

Figure 7: AIB and cable installation

Step 16 Install the new 128MB RAM SIMM into the motherboard. 
Insert the SIMM into the edge connector making sure of correct 
orientation. Use the retaining clips in the connector to secure the 
SIMM.

Audio bus cable, 
red wire to FRONT

USB/DC cable 

FRONT 

of card

AIB mounting screws
STATION INSTALLATION
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Step 17 Re-attach the upper section of the Station.

First re-connect the trackball cable to the motherboard, then 
reconnect the USB/power cable to the top panel PCB.

Step 18 Carefully replace to top panel and re-attach the seven retaining 
screws.

DREAM CONSOLE INSTALLATION
Step 1 Power down the console.

Step 2 Undo the retaining screws securing the rear of the console CPU 
tray. On a five bay console the CPU tray is at the right viewed 
from the rear, in a three bay console it is in the centre. Carefully 
slide the tray out as far as possible.

Step 3 Attach the two nylon spacers to the PCI rear support bracket with 
two M3 screws.

Step 4 Attach the PCI rear support bracket to the threaded standoffs 
next to the CDROM drive with two M4 screws.

M4 Mounting Screws

Nylon spacers
should be 
located here
UNPACKING
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Step 5 On a flat surface, assemble the mounting bracket, PCI riser card 
and DSP card as shown in the picture below. Insert the two M3 
screws as shown. Insert the two male/female M3 standoffs into 
the bracket.

Figure 8: Bracket/PCI Riser/DSP Card Assembly

Step 6 Carefully lift the assembly and insert it into the CPU tray as indi-
cated. Make sure the mounting bracket is aligned with the two 
stand-offs on the base of the tray and that the bracket is not 
obstructed by any of the existing cables. Adjust the cables if neces-
sary.

M3 Screw

M3 Screw PCI Riser Card

Insert M/F 
Standoffs Here
DREAM CONSOLE INSTALLATION
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Step 7 Carefully insert the PCI riser card into the PCI slot in the moth-
erboard and press down firmly until the card is fully inserted in 
the PCI edge connector.

Figure 9: Bracket/PCI Riser/DSP Card Installation

 Secure the bracket by inserting one M4 retaining screw through 
the heatsink on the rear panel of the tray. On early consoles this 
hole may be obscured by the heatsink. In this case, insert the 
screw from the inside of the bracket so that it extends about 3mm 
into the hole from the inside of the CPU tray.

SBO USB/DC 

M4 Bracket Screws

PCI Edge 

RAM 

Connector

SIMM

Connector

Support
Bracket
UNPACKING
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Insert the remaining two M4 retaining screws through the top of 
the bracket into the threaded standoffs on the base of the tray.

Step 8 Align the two holes in the end of the DSP card with the nylon 
spacers on the PCI rear support bracket. Attach the DSP card 
with the two M3 nylon nuts.

Step 9 Attach the AIB card to the bracket via the two M3 standoffs, 
secured with two M3 screws. Insert the final screw into threaded 
insert on the side of the CPU tray.

Step 10 Install the USB/DC cable (ABE1205-A) from the AIB card to 
connector JR3 on the SBO card as shown.

Figure 10: SBO USB/DC Connector
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Step 11 Install the audio bus cable (APIM201-A), note the orientation of 
the cable as shown.

Figure 11: AIB and cable installation

Step 12 Install the new 128MB RAM SIMM into the motherboard. 
Insert the SIMM into the edge connector making sure of correct 
orientation. Use the retaining clips in the connector to secure the 
SIMM.

Audio bus cable, 
red wire to FRONT

USB/DC Cable 

FRONT 

of card

AIB Mounting
Screws
UNPACKING
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Step 13 Check that all cables are still secure and slide the CPU tray closed. 
Re-insert the retaining screws in the tray.
DREAM CONSOLE INSTALLATION
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SOFTWARE INSTALLATION
Once the hardware has been installed, restart your SSM, Station or Console.
Make sure the system is running DREAM software version 2.0 or higher prior
to installing the Plug-Ins system. The software version is displayed in the
BLUE Utils menu.

Station/Console BIOS Settings
During boot-up of the Station or Console, hold down the Del key to display
the BIOS setup screen.

Step 1 Select Integrated Peripherals > System Share Memory 
Size >32MB.

Step 2 Save and Exit.

CreamWare Driver Installation
During boot-up the operating system will detect new hardware.

When the Found New Hardware dialogue for the Creamware DSP card is
displayed, insert the PIM Install disk. Select Search for a suitable driver
for my device and check the CD ROM option. Select the drivers, when
prompted, located on the PIM Install in SFP\Driver\Win2k\scopeWDM.inf.

If a Found New Hardware dialogue for the USB AIB card is displayed,
insert the Plug-Ins Manager 5 disk, select Search for a suitable driver for
my device and check the CD ROM option. Select the drivers, when
prompted, located on the PIM 5 CD in Drivers\FairUSB.inf.

Pulsar Software Installation
The Plug-Ins Manager system runs on a customised version of the Creamware
Scope Fusion Platform, that is supplied on the PIM5 CD. It is NOT possible
to run PIM5 with any other versions of Creamware software.

Step 1 Click on the Exit button on the DREAM Start splash screen if 
currently running.

Step 2 Insert the PIM Install CD.
STATION/CONSOLE BIOS SETTINGS
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Step 3 Click on My Computer on the Windows desktop and navigate 
to the CDROM. Double click on SetupSFP-###.bat file located 
in the root directory of the CDROM.

Step 4 Select the Language, and click Next when prompted, then at the 
Readme file and License agreement click Accept if you accept 
the terms of the agreement.

Step 5 Select the default installation Folder C:\SFP and click Next. Do 
not alter this path.

Step 6 If installing a 6 DSP card, select the package named Pulsar.

OR

If installing a 15 DSP card, select the package name Scope.

Step 7 Check the Product Activation Keys card that is supplied with the 
Plug-Ins kit. This card contains the activation keys for the 
CreamWare DSP card and all the software Plug-Ins supplied with 
the Plug-Ins Manager.

To activate each product, click in the enter key field next to the 
products listed in the dialog box and enter the keys from the 
labels on the card. Retain this card in a safe place for future refer-
ence.

Click Next.

Step 8 When prompted to Select the VST Plugins folder for 
XTC components, leave the text boxes blank or click the Dis-
able buttons to clear them, then Next.

Step 9 Finally, click Finish.

PIM5 Software Installation
Plug-Ins Manager 5 must now be installed.

Step 1 Insert the Plug-Ins Manager 5 CD. Click on My Computer on 
the Windows desktop. Navigate to the CDROM and double 
click on the SetupPIM file. The PIM 5 Installer will run display-
ing the PIM installation Welcome screen.

Step 2 Click Next, then read the End User License Agreement. If you 
accept the agreement, click Yes. 
SOFTWARE INSTALLATION
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Step 3 Click Next to start copying the files.

Step 4 Click the Finish button to quit the installer when finished.

Documentation Installation
The on-line version of this manual includes additional chapters on using all the
plug-ins supplied with Plug-Ins Manager. Once installed the manual can be
found by clicking on the Start menu and selecting Programs > Fairlight
> Docs

User Manual
Step 1 Insert the Plug-Ins Manager 5 CD. Click on My Computer on 

the Windows desktop. Navigate to the CDROM and double 
click on the SetupPIMDocs file. The PIM 5 Documentation 
Installer will run displaying the PIM installation Welcome 
screen.

Step 2 Click Next to start copying the files.

Step 3 Click the Finish button to quit the installer when finished.

Acrobat Reader
Step 1 Insert the Plug-Ins Manager 5 CD. Click on My Computer on 

the Windows desktop. Navigate to the CDROM and double 
click on the SetupAcrobatReader file. The PIM 5 Documentation 
Installer will run displaying the PIM installation Welcome 
screen.

Step 2 Click Next to start copying the files.

Step 3 Acrobat Reader Installer will run. Follow the prompts to set up 
Adobe Acrobat Reader.

Step 4 Click the Finish button to quit the installer when finished.
DOCUMENTATION INSTALLATION
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SSM Installation
If running Plug-Ins Manager on an SSM you must also install Plug-Ins Man-
ager on the Station or Console. This is necessary only to install the plug-ins,
flexiSurface maps and ancillary PIM components. The Plug-Ins Manager
application itself, only runs on the SSM but the installation must be performed
on the Station or Console. If running Plug-Ins Manager in the Station or Con-
sole, ignore this step.

Step 1 Click on the Exit button on the DREAM Start splash screen if 
currently running.

Step 2 Insert the Plug-Ins Manager 5 CD in the Station or Console CD 
ROM drive. Click on My Computer on the Windows desktop. 
Navigate to the CDROM and double click on the SetupPIM file 
The PIM 5 Installer will run displaying the PIM installation 
Welcome screen.

Step 3 Click Next, then read the End User License Agreement. If you 
accept the agreement, click Yes. 

Step 4 Click Next to start copying the files.

Step 5 Click the Finish button to quit the installer when finished.

Step 6 Restart the Station or Console computer. Click on the Start 
Menu and select Shutdown > Restart.

Add Startup Shortcut
Adding Plug-Ins Manager to the startup directory will make Plug-Ins Manager
run automatically every time you start up your system.

Step 1 Right click on the task bar at the bottom of the Windows desk-
top.

Step 2 Click Properties, then click on the Advanced tab.

Step 3 Click the Add button, then click the Browse button and navi-
gate to C:\Program Files\Fairlight\Plug-In Manager\Plug-In Man-
ager.exe.

Step 4 Click Next then scroll down the destination folder list to Start 
Menu > Programs > Startup, then click Next.
SOFTWARE INSTALLATION
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Step 5 Click Next to accept the shortcut name, then click Finish.

If running Plug-ins Manager internally on a Station or Console, the short-cut
properties must be set to Run Minimized. For SSM systems, the short-cut is
set to Run Maximized.

Step 1 Click on the Start menu and right click Programs > Startup > 
Plug-In Manager and select Properties from the context 
menu.

Step 2 Click on the Run: drop-down list and select Minimzed or 
Maximized, as appropriate for you system.

Add System Variables
The QDC I/O used to support Plug-Ins must now be defined. Plug-Ins
requires a block of 16 AES I/O.

Step 1 On the Station or Console, click on My Computer on the Win-
dows desktop and navigate to C:\Program Files\Fair-
light\FMC\Data\System_Variables.txt. Double click on the file to 
open it in the Windows Notepad editor.

Step 2 Edit the following lines:

PLUGINS_IO_START,1
PLUGINS_IO_RANGE,16

The plug-ins I/O takes up a block of 16 AES I/Os. The start 
number should be 1, 17, or 33 depending on which I/O in your 
system you wish to use.

Step 3 Save the file and exit Notepad. 
ADD SYSTEM VARIABLES
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DREAMStart Setup
The DREAMStart application is used to configure the Fairlight Mixing Con-
sole application for use with plug-ins.

Figure 12: DreamStart Setup Page

Step 1 Click on the Start button on the Windows desktop and select 
Programs>Fairlight>DREAMStart.

Step 2 Click on the Setup binnacle key on the DREAMStart display to 
access the DREAM Setup page.

Step 3 Click on the Plug-ins Setup drop-down list in the DREAM 
Surface Options section of the Setup page. Select INTERNAL 
for running plug-ins internally in your Station or Console. Select 
EXTERNAL for running plug-ins in an SSM.

Step 4 If running plug-ins in an SSM, enter the IP address of the SSM in 
the Plug-ins IP Address field. This field is ignored if running 
plug-ins internally. See Network Settings below.

Step 5 Click OK to accept changes and exit the setup page.
SOFTWARE INSTALLATION
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Network Settings
If running Plug-Ins Manager in a Fairlight System Services Module PC, make
sure that the SSM is connected to the Station or Console via a 100BaseT eth-
ernet hub and that the IP address is within the same subnet and unique.

Figure 13: SSM Network Settings

To configure the SSM network settings follow these steps:

Step 1 Right click on My Network Places on the Windows desktop 
to open the Network and Dial-up Connections dialogue box. 
Select Properties.

Double click Local Area Connection, then click Proper-
ties.

Double click TCP/IP and set the SSM's IP address. Ensure the IP 
address is unique and within the subnet range of the engine and 
console. It is common practice to set the last number in the SSM 
IP address to a value 100 higher than the Console or Station. For 
example, if the Station or Console’s IP address is 10.1.1.111, 
make the SSM IP address 10.1.1.211.

Step 2 Press Tab to get the default Subnet Mask 255.255.255.0, 
then click OK.

Step 3 Tick the Show icon in taskbar box, then click OK and 
Close.
NETWORK SETTINGS
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FlexiSurface File
By default, all plug-in parameters are mapped to faders, pan and mute controls
on the first twelve faders of a Console or Sidecar. No changes to the FlexiSur-
face configuration are required, however, sophisticated customisation is pos-
sible using the FlexiSurface system. 

If no Sidecar is available in a Station system the FlexiSurface file may need to
be modified. 

The FlexiSurface file defines which physical controls on the control surface are
available to be mapped to control plug-in parameters. Parameters may be
mapped to pan, mute and fader controls on a fader panel or Sidecar, or to the
rotary controls and switches on the parameter pad of a Station. 

To edit the file click on the Start menu and select Programs>Accesso-
ries>Notepad. File>Open from the Notepad menu and navigate to
C:\Program Files\Fairlight\FMC\Data\FlexiSurface.txt and open the file.

When mapping to a fader panel edit the file to select the target fader strips.
Each fader strip must be listed in the file with an entry, for example, FADER-
STRIP,1. The default flexisurface maps include twelve faders. Any number
of faders may be used, however, each plug-in FlexiSurface map file must be
modified to suit the configuration.

When mapping to the Station Parameter Pad the file merely contains one
PARAPAD entry, all FADERSTRIP entries must be removed. The plug-in
FlexiSurface map files must be modified to suit this configuration.

See the FlexiSurface Maps chapter in the PIM 5 User Manual for more details.

Restart System
Step 1 You must now restart your computer. Click on the Start Menu 

and select Shutdown > Restart.
SOFTWARE INSTALLATION
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Starting Plug-Ins Manager
Plug-Ins Manager 5 must be started prior to launching FMC. To start Plug-
Ins Manager, click on the Start menu and select Programs>Fairlight
ESP>Plug-In Manager.

A short-cut to Plug-Ins Manager should be added to the Windows Startup
directory as described above. This causes Plug-Ins Manager to run automati-
cally when the system is powered on. For Stations or Consoles running In-
Screen, the short-cut properties are set to Run Minimized. For SSM systems,
the short-cut is set to Run Maximized. 

Once Plug-Ins Manager is running you may proceed to start FMC from
DREAMStart in the normal manner.
STARTING PLUG-INS MANAGER
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Chapter 3 -  Using Plug-Ins

INTRODUCTION
Plug-ins are inserted into feeds from the insert menu. This provides consider-
able flexibility allowing plug-ins to be inserted directly into a track feed, or into
a live feed whose input is sourced from an auxiliary bus, for example. This
allows the Aux Bus to drive the plug-in, with the return being the Live Feed in
which the plug-in is inserted.

Starting Plug-Ins
Plug-Ins Manager must be started prior to launching FMC. Plug-Ins Manager
may be launched from the Start menu, or by copying a shortcut to the Win-
dows Startup directory. Follow the steps in the installation chapter to get the
system working.

PATCHING A PLUG-IN
Both stereo and mono plug-ins are supported. Stereo plug-ins may be inserted
across a stereo link group. If a stereo plug-in is inserted on a mono feed, the
right channel is inserted in the adjacent feed.

Step 1 Call the feed on which you wish to insert a plug-in.

Step 2 Press the Insert key on Station or Insert Config on Console to 
display the Insert menu.

Step 3 Press the Add Plug-In soft key.

Step 4 Use the jog wheel or arrow keys to scroll through the list of avail-
able plug-ins.

Step 5 Press the Add soft key to instantiate the plug-in in Plug-Ins Man-
ager.

There may be some delay while the plug-in instantiates. The 
insert patching is displayed on the channel display at the bottom 
of the mixer display and the insert is switched in. A small purple 
P in the channel tile of the selected feed indicates that it has a 
plug-in.
STARTING PLUG-INS
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When running plug-ins in-screen on Station or Console, the 
plug-in is displayed on top of the mixer display.

When running on an SSM the plug-in is displayed in the Plug-
Ins manager window on the SSM display.

Step 6 When using a plug-in that has a valid FlexiSurface map file, the 
plug-in parameters may be controlled from the fader panel or 
Sidecar by pressing the Plug-Ins key located below the Parame-
ter Pad on Station or between the Direct Config and SIP 
Defeat keys at the top of the Channel Panel on Console.

Parameters are mapped to the Pan, Mute and Fader controls on a 
fader panel on the Console or Sidecar, or to the rotary controls 
and switches on the Parameter Pad. See the FlexiSurface Maps 
chapter for details on custom maps.

Step 7 To remove a plug-in, press the Remove Plug-In soft key in 
the Insert menu.

CONTROLLING PLUG-INS
Plug-in parameters can be controlled using the trackball when running in the
Station or Console, or the mouse when running in an SSM, or from the phys-
ical controls of the control surface. The mapping of parameters to controls is
configured in a special mapping file which is described in the FlexiSurface
Maps chapter. Default mapping files are supplied for all supplied plug-ins.

The Plug-Ins key on the Parameter Pad on Station, or Channel Panel on
Console is dimly lit if the called feed has a plug-in inserted. Pressing the Plug-
Ins key will display the plug-in graphical interface on screen, and the faderset
map on the control surface as described below.

Using the Trackball
When running plug-ins internally in the Station or Console, the trackball can
be used to control the plug-in’s graphical interface. When running in an SSM,
the SSM’s mouse can be used.

Once a plug-in is inserted in a feed, its graphical interface is displayed on the
screen whenever the feed is called and the Plug-Ins key on the Parameter Pad
CONTROLLING PLUG-INS
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on Station or Channel Panel on Console is pressed. Use the mouse to click and
drag on any parameter control. 

To gain more resolution when controlling a knob, click in the centre of the
knob then move the pointer to the top edge of the screen, then move the
pointer from left to right to adjust the value.

Using the Control Surface
Plug-in parameters can be controlled from the fader, mute and pan controls on
a fader panel or Sidecar, or from the encoders and switches on the Station
Parameter Pad. The default FlexiSurface mapping places each parameter under
the control of an appropriate fader, rotary encoder or switch.

Once a plug-in is inserted in a feed, its graphical interface is displayed on the
screen whenever the feed is called and the Plug-Ins key is pressed.

The parameter names are displayed in the LCD windows above the faders or
next to the controls in the Parameter Pad. Changes made to any parameter via
the control surface are displayed in the plug-ins graphical interface.

The selection of a specific group of faders, or the Parameter Pad for use with
plug-ins is made in the FlexiSurface file. See “FlexiSurface File” on page 2-31.

FAVOURITES
The FAV favourites soft key in the Insert menu displays a list of user selected
plug-ins. This allows the user to quickly find the plug-ins they use most often
without having to scroll through the entire list of available plug-ins.

Each user has their own unique favourites list. If you have logged on to the
system as a different user, your favourites list will not be available.

Adding to Favourites
Step 1 Press the Insert key on Station or Insert Config on Console to 

display the Insert menu.

NOTE: Do not click on the cross at the top right of a plug-in 
graphical interface. Always use the Remove Plug-In soft key 
in the Insert menu to remove plug-ins.
USING THE CONTROL SURFACE
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Step 2 Press the Add Plug-In soft key.

Step 3 Press the ALL soft key to display the complete list of plug-ins on 
your system.

Step 4 Turn the jog wheel to scroll down the list of available plug-ins and 
find the one you wish to add.

Step 5 Press the ADD TO FAV soft key to add the plug-in the favourites 
list.

Selecting Favourites
Step 1 Call the feed on which to insert a plug-in.

Step 2 Press the Insert key on Station or Insert Config on Console to 
display the Insert menu.

Step 3 Press the Add Plug-In soft key.

Step 4 Press the Fave soft key to display the favourites list.

Step 5 Turn the jog wheel to scroll down the list of favourite plug-ins.

Step 6 Press the Add soft key to insert the plug-in.

APPROVED 3RD PARTY PLUG-INS
Fairlight maintains a list of approved third-party plug-ins which have been
tested and verified for stable operation and good performance on the DREAM
Plug-Ins Manager system. Check the Plug-Ins Manager page on the Fairlight
web site at www.fairlight.net for details of the latest plug-ins.

Adding New Plug-Ins
Follow the instructions included with the plug-in you have purchased, and any
special instructions provided on the Fairlight web site. The plug-in device file
must be copied to the C:\SFP\Devices\Fairlight\PlugIns directory. Plug-ins
device files are named with either a .mdl or .dev file extension. Your new plug-
in will now appear in the All plug-ins list in the Insert menu.
APPROVED 3RD PARTY PLUG-INS



3-6
ADDING NEW PLUG-INS



4-1
NOTES:



4-2
Chapter 4 -  The Plug-Ins
This chapter lists all the standard plug-ins and describes all the plug-in param-
eters.

In the initial release of Plug-Ins Manager 5, the insert patching system only
allows signals to be patched to the main mono or stereo inputs and outputs of
a plug-in. Some of the plug-ins described below include side-chain signal
inputs. These inputs are currently inaccessible.

In addition to the plug-ins listed below, the SPL Attacker, SPL Transient
Designer and Vinco compressor have all been mapped for use with Plug-Ins
Manager. These additional plug-ins may be putchased from the Creamware
web site.

Use the index below to quickly locate a plug-in.

MasterVerb Pro
MasterVerb and MasterVerb 
Classic
E-Reflector
Compressor M/S
Limiter M/S
Gate M/S
Expander M/S
De-Esser
Low Cut M/S
High Cut M/S
Delay LM/M and LS/S
Delay LCR LS and S
Dual Delay LS and S
Multitap M/S
Ducking Delay M/S
Pattern Delay
Distortion M/S
TDrive M/S and TQDrive M/S
AutoWah M/S
Chorus S and Harmonic Chorus S
Master Chorus M/S

Hexa Chorus S
4Tap Chorus S
Flanger M/S, Harmonic Flanger S
Master Flanger M/S
Random Flanger M/S
Space Flanger M/S
Step Flanger M/S
Phaser M/S
What is SSB?
SSB Phaser M/S
SSB Modulator M/S
SSB Delay M/S
Pitch Shifter M/S
4-Pole Filter M/S
Resonator M/S
Ring Modulator M/S
Tremolo M/S
Autopan
Stereo Pan
StereoExpander
Soft Clip M/S
DC Filter M/S
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MASTERVERB PRO
MasterVerb Pro combines a high-end reverb with a very user-friendly interface.

Based on the reverb algorithms of the MasterVerb, MasterVerb Pro further
improves on the naturalness of the reverberation. In addition to a fixed selec-
tion of early reflection models, you can now create as many of your own models
as desired using the Source Image Method. This method employs easy X/Y
controls to compute realistic early reflection signals of an acoustic source
(Source) relative to a listener (Destination). If desired, you can also include the
distance of the source to the listener and the source pan position as part of the
calculation. Reverb Colour and stereo spread (Width) controls enhance the
overall impression of spaciousness. Applying Chorus to the response guaran-
tees sonic density and also opens the door for some interesting special effects.

The MasterVerb Pro algorithm is split into two sections–the production of
early reflections, and the production of a response signal pattern. The early
reflections are responsible for producing the impression of space, while the
response signal creates the atmosphere. You can adjust the overall tone quality
of the space with the filters in the input and response sections. The X/Y con-
trols provide direct access to the most important early reflection and response
parameters.
MASTERVERB PRO
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Source Image
MasterVerb Pro computes early reflections using a
simple geometric model. In this model, acoustic
waves are treated much like rays of light. Acoustic
waves emanate radially, like light, but from an
acoustic source (Source=S). The waves then reflect
from walls or surfaces the way light is reflected when
it meets a mirror. For consistency with the light
analogy, we also assume that the walls are very large
with respect to the wavelengths of the sound waves.
High frequency absorption is ignored for the time
being.

If the position of the listener is well defined (Destina-
tion=S), the sound wave transmitted from the
acoustic source to the wall and then to the listener
could be regarded as if the wall doesn’t exist. In this
new view, another acoustic source lies behind the
position of the wall and transmits a sound wave

directly to the listener. We could regard this second source as a phantom
acoustic source. Finally, individual phantom sources are defined for each wall.
This procedure is applied repeatedly to create a sufficient number of phantom
sources as required to represent the area model. MasterVerb Pro uses sixteen
early reflections to define the space.

This description of a source with mirror-image phantom sources is known as
the Source Image Method. Simply stated, this model describes the behaviour
of acoustic waves in an area with an enclosed source and several other non-
enclosed copies of the source.

The wall absorption factor, ignored previously, can be effectively reproduced
with the filters in the MasterVerb Pro’s input section. However, this model
does not take into account the existence of a floor and ceiling for the acoustic
area. This model should not, therefore, be considered as a complete room sim-
ulation. Nevertheless, the results are very convincing, and the MasterVerb Pro
fully meets all professional post production requirements.
SOURCE IMAGE
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Controls

Input Gain
Controls the level of the signal to be proc-
essed. A VU-meter displays the level of the
signal as adjusted. A small mark next to
the control indicates unity gain. When
adjusted to the left of the mark, the signal
is attenuated. To the right of the mark, the
signal is amplified.

Low Pass Filter
A low pass filter with a slope of 12db/
octave follows the gain control in the

signal path. There are three ways you can adjust the cutoff frequency: Use the
rotary control, enter the value in the text field, or adjust the value directly in
the graphic display area using the mouse.

Rooms or halls we classify as “warm” absorb most of the high frequencies–
those over 8 kHz (or less). Use the low pass filter to create a warmer response.

High Pass Filter
A high pass filter, also with a slope of 12db/octave, follows the low pass filter
in the signal path. As with the high pass filter, there are three ways to adjust the
cutoff frequency: Use the rotary control, enter the value in the text field, or
adjust the value directly in the graphic display area using the mouse.

The response of many halls lies mainly within the middle frequencies.
Together, the low pass and high pass filters form a band pass filter, attenuating
both high and low frequencies. Appropriate adjustment of the two filters repro-
duces the sound of a hall in which the midrange is favoured.

Reverb Colour
Reverb Colour controls the tone quality of the room from bright to dark. The
results affect the apparent warmth and volume of the room. With darker
colour settings, the low frequencies resound longer than the high frequencies.
MASTERVERB PRO
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Early Reflections
Early reflections in the MasterVerb Pro are built up from sixteen individual
“echoes”. You can control the form and process of the early reflections by
adjusting the parameters described below. The filters (mentioned previously)
affect the tone quality of the early reflections. The pre-defined ER models in
the selection provided have been specifically designed to produce useful space
impressions and musical effects.

MasterVerb Pro features a Source-Image mode to provide simplified control of
the major parameters by letting you position an acoustic source (Source) and a
listener (Destination) within a defined area. This positioning is enough to pro-
duce useful early reflections models. If desired, you can also include the dis-
tance of the source to the listener and the pan position of the source in the
computation. The X/Y control adjusts the two most important parameters–ER
Size and ER Shape–simultaneously.

ER Type (Early Reflections Type)
In the drop-down menu, select an Early Reflections model. The model you
select determines the impression of space. You can select from among 11 spe-
cifically designed models. The twelfth model, SourceImage, enables computa-
tion mode.

ER Delay (Early Reflections Delay)
Delay, in milliseconds, of the early reflections. This is not associated with the
Pre Delay except insofar as the room effect is influenced by the ER Delay only
if Pre Delay is enabled (see the Pre Delay parameter).

ER Size (Early Reflections Size, X-Control)
You can edit Room Size and Rev Time parameters simultaneously using an X/
Y control. The most important parameters are thus directly accessible.

ER Shape (Early Reflections Shape, Y-Control)
The Shape parameter determines the decay “envelope” –the decay curve. An
envelope with an exponential shape, as adjusted by setting ER Shape to its
maximum value, produces the most natural effect.
EARLY REFLECTIONS
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ER Decay (Early Reflections Decay)
Controls how the early reflections die away over time. With higher values: the
greater the delay with respect to the original signal, the quieter the reflections
become. For a natural effect, set the decay to its maximum value to shorten the
early reflections.

Invert
Inverts the decay envelope of the early reflections. In other words, the Early
Reflections model remains the same, but each reflection acquires a gain, rather
than a diminution, of volume.

This effect is not found in natural acoustical systems, but can be interesting as
a special effect.

Reverb
The following parameters control the
behaviour of the overall response, and
are available in both versions of the
reverb. In this section the tone quality
is also determined by the settings of
the filters mentioned previously. You
can edit Room Size and Rev Time
parameters simultaneously using an
X/Y control. The most important
parameters are thus directly accessible.

Rev Delay (Reverb De-
lay)
Adjusts the delay of the response in
milliseconds. This is distinct from a
Pre-delay as the early reflections or
reflections are not affected by this set-
ting.

The Reverberation Delay is used to separate the hall response from the direct
signal and the early reflections. This is useful to increase the comprehensibility
of vocals or speech. The impression of space is not altered, as the early reflec-
tions are not changed.
MASTERVERB PRO
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Pre Delay
This switch automatically sets the overall response delay to the delay time of
the first of the early reflections. When enabled, the functionality corresponds
to a classic Pre Delay, and is adjustable with the ER Delay control.

Room Size (X-Control)
Adjusts the apparent room size. This control applies only to the reverb portion
of the signal.

In order to avoid interference, the response is muted for brief periods of time
when adjusting the room size.

Reverb Time (Y-Control)
Controls the reverb time (duration). The reverb time is unlimited, and can
even be adjusted to infinity if desired.

As in a real-world acoustical environment, long reverb times correspond to
large rooms. In small rooms, use shorter times to produce a natural sounding
response.

HiDamp Filter (High Damp Filter)
This 6 db/octave filter operates on the reverb response. This filter reduces the
high frequencies in the response signal depending on how it is adjusted. There
are three ways you can adjust the cutoff frequency: use the rotary control; enter
the value directly in the text field; or adjust the value directly in the graphic dis-
play area using the mouse.

Rooms or halls absorb high frequencies quite strongly. Therefore, settings
between 3 kHz and 6 kHz are typical.
REVERB
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Shape
The Shape control lets you change the envelope of
the response signal. Lower values correspond to
relatively fast rise and fall times, while larger
values result in slower rise and fall times. The
effect is analogous to moving a wall, or raising or
lowering the ceiling in a concert hall. The
apparent size of the space changes correspond-
ingly.

For percussive sounds like drums or other percus-
sion instruments, smaller values for the Shape
parameter are best.

Diffuse

This setting controls the density of the response
during the first milliseconds. For large rooms or
halls, this should be set to maximum. When sim-
ulating smaller spaces, reducing the level results in
added presence to the sound.

In the MasterVerb Classic version, this setting also affects the density of the
reflections.

Definition
The definition control adds response echoes similar to those produced in a
room with smooth walls. This setting controls the “liveness” of the overall
effect.

Chorusing
You can insert chorusing in the response to enrich the resonance of the reverb,
making it sound less static. Some instruments can handle more of a chorus
effect than others. Drums and vocals generally benefit from chorusing, whereas
instruments with a steady, clearly defined pitch (like guitar or piano) can
handle somewhat less of the effect. Too much of the effect on these instru-
ments alters their pitch in the response making them sound unsteady. Use little
or no chorusing in the reverb for these instruments.
MASTERVERB PRO
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Rate
Controls the modulation speed of the Chorus’ delay. You can get the most out
of the chorus effect by judiciously adjusting the modulation speed for specific
instruments.

Source Image

Source Image
Switches on the automatic computation of the Dry/Wet relationship and the
Pan position of the acoustic source. The computation is based on the distance
from the listener to the source. Before you can use this feature SourceImage
must be the selected model in the ER Type menu.

Effect Intensity
Determines the minimum effect proportion through automatic calculation of
the Dry/Wet relationship.

In Out Section

Dry/Wet
Controls the relative levels of the direct
and effect signals.

Wet 100%
Switches the direct signal off. The
resulting effect output signal contains only
the reverb portion (100% effect).

ER
Controls the volume level of the early reflections.

ER Mute
Switches off the Early Reflections.

Reverb
Adjusts the proportion of the response signal.

Reverb Mute
Switches the response signal off.
SOURCE IMAGE
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Reverb Width
Adjusts the stereo spread of the effect signal. The spread is adjustable from
mono to stereo with complete separation of left and right signal components
possible. Double-clicking the control sets it to a normal stereo spread.

Creating Reverb Settings
Creating good presets with a reverb processor that offers so many parameters
requires a good ear and some experience. To help you along, we offer some tips
for creating your own presets.

First listen to the original signal alone by clicking the mute buttons for Early
Reflections and Reverb. After you have listened carefully to the source signal,
switch off muting for the Early Reflections signal and select a model corre-
sponding to your basic idea of the room desired. Next, adjust the early reflec-
tions until they produce the desired room effect more exactly. Make several
comparisons between the original signal and the processed signal as you pro-
ceed.

After you have established suitable settings for early reflections, switch in the
reverb (response). Adjust the room size of the reverb signal so that the character
of the reverb signal matches the character of the early reflections. Next, adjust
the reverb time. Here the “less is more” principle applies. This is especially true
when you get to the final mix, in which reverb times that are too long can pro-
duce disturbing results. Finally, fine-tune the effect with the Diffuse, Shape,
and Definition controls.

With a little practice you’ll get consistently good results without too much
effort. 
MASTERVERB PRO
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MASTERVERB AND MASTERVERB CLASSIC
These effects simulate concert hall reverberation. Each of the two versions con-
sists of one section to produce the initial echoes (early reflections) and a second
to produce the response (reverb or response). Early reflection, or more pre-
cisely, the pattern of early reflections, is essentially responsible for the percep-
tion of space–the size of the hall. The response signals produce the overall
atmosphere. Filters in the input and response sections control the tonal colour
of the hall.

The MasterVerb produces a range of authentic early reflection models, while
the Classic version provides only a single simulation of early reflections. With
regard to DSP usage, the Classic version is more economical than the Mas-
terVerb. The Masterverb’s DSP cost is justified by a more realistic impression
of space, however. The reverb section is identical in both versions. Choose the
version to use with respect to the production requirements. For an accurate
sense of spaciousness, use the MasterVerb. To save DSP resources, or to pro-
duce only the atmospheric component, use the Classic version.
IN OUT SECTION
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Input Gain
Controls the level of the signal to be processed. A VU-meter displays the level
of the signal as adjusted. A small mark next to the control indicates unity gain.
When adjusted to the left of the mark, the signal is attenuated. To the right of
the mark, the signal is amplified. 

Low Pass Filter
A low pass filter with a slope of 12db/octave follows the gain control in the
signal path. There are three ways you can adjust the cutoff frequency: Use the
rotary control, enter the value in the text field, or adjust the value directly in
the graphic display area using the mouse. Rooms or halls we classify as “warm”
absorb most of the high frequencies those over 8 kHz (or less). Use the low pass
filter to create a warmer response.

High Pass Filter
A high pass filter, also with a slope of 12db/octave, follows the low pass filter
in the signal path. As with the high pass filter, there are three ways to adjust the
cutoff frequency: Use the rotary control, enter the value in the text field, or
adjust the value directly in the graphic display area using the mouse. 

The response of many halls lies mainly within the middle fre-
quencies. Together, the low pass and high pass filters form a band
pass filter, attenuating both high and low frequencies. Appro-
priate adjustment of the two filters reproduces the sound of a hall
in which the midrange is favoured.
MASTERVERB AND MASTERVERB CLASSIC
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Early Reflections (MasterVerb only)
In the MasterVerb, the early reflection response is made up of 16 individual
“echoes”. Adjust the configuration and characteristics of these as described in
the following parameters. The filters described previously influence their tone
quality.

Early Refl. (Early Reflections)
This button sets the graphic area to display Early Reflections settings. ER Type
(Early Reflections Type) From the drop-down list select an early reflection
model. The model chosen determines the quality of the spatial impression.

ER Spread (Early Reflections Spread)
Selects the apparent size of the hall to be processed for early reflections.

ER Decay (Early Reflections Decay)
Controls how the early reflections die away over time. With higher values: the
greater the delay with respect to the original signal, the quieter the reflections
become. For a natural effect, set the decay to its maximum value to shorten the
early reflections.

ER Shape (Early Reflections Shape)
The Shape parameter determines the decay “envelope” –the decay curve. An
envelope with an exponential shape, as adjusted by setting ER Shape to its
maximum value, produces the most natural effect.
EARLY REFLECTIONS (MASTERVERB ONLY)
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Invert
Inverts the decay envelope of the early reflections. In other words, the Early
Reflections model remains the same, but each reflection acquires a gain, rather
than a diminution, of volume. This effect is not found in natural acoustical sys-
tems, but can be interesting as a special effect.

Reflections (MasterVerb Classic only)
The Reflections section of the MasterVerb Classic produces simulated early
reflections at a much lower computational cost than the MasterVerb. The
Reflections simulation is achieved by taking part of the response (reverb)
signal, splitting it, and delaying it using individual delays for the left and right
stereo channels. The density of the Reflections signal results from the settings
of the Reverb parameters (q.v.). The filters described previously control the
tone quality. This method of producing early reflections is typical of older dig-
ital reverberation techniques, therefore the “Classic” designation in the name.

Reflections
This button sets the graphic area to display Reflections settings.

Reflect L (Reflections Left)
Sets the volume and delay for reflections in the left side of the stereo image.

Reflect R (Reflections Right)
Sets the volume and delay for reflections in the right side of the stereo image.
Depending on their adjustment, the reflections may sound very distinctly, as is
appropriate for smaller rooms. For large rooms, using the reverb section alone
may be sufficient.

Reverb
The following parameters control the behaviour of the overall response, and are
available in both versions of the reverb. In this section the tone quality is also
determined by the settings of the filters mentioned previously.

Reverb
Sets the graphic display to show the reverb parameters.
MASTERVERB AND MASTERVERB CLASSIC
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Rev Delay (Rev Delay)
Adjusts the delay of the response in milliseconds. This is distinct from a Pre -
delay as the early reflections or reflections are not affected by this setting. The
Reverberation Delay is used to separate the hall response from the direct signal
and the early reflections. This is useful to increase the comprehensibility of
vocals or speech. The impression of space is not altered, as the early reflections
are not changed. 

Diffuse
This setting controls the density of the response during the first milliseconds.
For large rooms or halls, this should be set to maximum. When simulating
smaller spaces, reducing the level results in added presence to the sound. In the
MasterVerb Classic version, this setting also affects the density of the reflec-
tions.

Room Size
Adjusts the apparent room size. This control applies only to the reverb portion
of the signal. In order to avoid interference, the response is muted for brief
periods of time when adjusting the room size. 

Time
Controls the reverb time (duration). The reverb time is unlimited, and can
even be adjusted to infinity if desired. As in a real-world acoustical environ-
ment, long reverb times correspond to large rooms. In small rooms, use shorter
times to produce a natural sounding response.
REVERB
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HiDamp Filter (High Damp Filter)

This 6 db/octave filter operates on the reverb response. This filter reduces the
high frequencies in the response signal depending on how it is adjusted. There
are three ways you can adjust the cutoff frequency: use the rotary control; enter
the value directly in the text field; or adjust the value directly in the graphic dis-
play area using the mouse. Rooms or halls absorb high frequencies quite
strongly. Therefore, settings between 3 kHz and 6 kHz are typical.

Shape
The Shape control lets you change the envelope of the response signal. Lower
values correspond to relatively fast rise and fall times, while larger values result
in slower rise and fall times. The effect is analogous to moving a wall, or raising
or lowering the ceiling in a concert hall. The apparent size of the space changes
correspondingly. For percussive sounds like drums or other percussion instru-
ments, smaller values for the Shape parameter are best.

Definition
The definition control adds response echoes similar to those produced in a
room with smooth walls. This setting controls the “liveness” of the overall
effect. 

Dry
Controls the volume level of the original signal (without the effect). 

Dry Mute 
Switches off the original signal (only the effect signal will be heard).

ER (MasterVerb only)
Controls the volume level of the early reflections.
MASTERVERB AND MASTERVERB CLASSIC
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ER Mute (MasterVerb only)
Switches off the Early Reflections.

Reflect (MasterVerb Classic only)
Controls the volume level of the reflection signals.

Reflect Mute (MasterVerb Classic only)
Switches the reflection signals off.

Reverb
Adjusts the proportion of the response signal.

Reverb Mute
Switches the response signal off.

Wet
Controls the volume level of the overall effect signal.
REVERB
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E-REFLECTOR
This effect simulates the initial echoes (early reflections) of acoustical spaces,
rooms or halls. As in the real world, the impression of space results from the
combined effect of many individual echoes. Overlaying these signals results in
phase cancellations that provide the distinctive character of that particular
environment. As well as real spaces, experimental or theoretical examples are
also provided. Filters in the input section can be used to change the tone
quality of the signals.

Input Gain
Controls the level of the input signal. A level meter serves to help you optimise
the level. The small dot indicator next to the Gain control indicates unity gain.
If the control is adjusted below the indicator, the signal is attenuated. Above
the indicator, the input signal is amplified. 

Lowpass Filter 
A low pass filter with a slope of 12db/octave follows the gain control. Adjust
the frequency of this filter a) with the rotary control, b) by entering the value
in the text field, or c) directly with the filter’s graphic control interface. 

Highpass Filter 
After the low pass filter lies a high pass filter with a slope of 12db/octave. Adjust
the frequency of this filter a) with the rotary control, b) by entering the value
in the text field, or c) directly with the filter’s graphic control interface.
E-REFLECTOR
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Early Reflections
Early reflections are composed of sixteen individual echoes. You can control
the nature and shape of these echoes with the following parameters. The filters
described previously determine the overall tone quality of early reflections.

ER Type (Early Reflections Type)
From the drop-down list select an Early Reflections model (type). This deter-
mines the overall impression of this acoustical space.

ER Spread (Early Reflections Spread)
Adjusts the size of the apparent space.

ER Decay (Early Reflections Decay)
Controls how quickly the early reflections die away (that is, the degree of atten-
uation of the signal with increasing delay). For natural-sounding effects set the
ER Decay to maximum for a quick decay.

ER Shape (Early Reflections Shape)
This parameter also controls the way the early reflections die out - in this case
by adjusting the shape of the envelope curve of the signal decay. For natural
sounding effects use an exponential curve by setting ER Shape to its maximum
value.

Linear Envelope Exponential Envelope
EARLY REFLECTIONS
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Invert
When selected, the gains of the individual reflections are reflected around the
centre point. That is, the Early Reflections model remains the same, but the
envelope is inverted. This acoustic scenario does not exist in nature. However,
as a special effect it is very interesting and useful.

Inverted Cluster
E-REFLECTOR
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COMPRESSOR M/S
This effect is provided in both mono and stereo versions. The operation and
functionality is identical in each version. A Compressor modifies the dynamics
of a sound. The level of louder passages is decreased. This means that the
overall level of the sound can be set higher, with the net result that the level of
softer sections is increased. The compressor operates by monitoring the level of
the input signal. An adjustable threshold level determines the point at which
compression begins. Attack and release controls determine how quickly the
compressor responds when the threshold is exceeded and when the input signal
level falls back below the threshold, respectively. The ratio control determines
the intensity of the compression – i.e., the ratio of input level change to output
level change. The gain control adjusts the level of the compressed signal. The
Side Chain In can be used to permit a signal other than the primary input
signal to be used for analysis and control. The dynamics of the signal appearing
at the Side Chain input will then control the response of the primary audio
signal being processed.

Plug-Ins Manager does not currently provide the means for
patching sidechain signals.
EARLY REFLECTIONS
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Displays

In
Displays the input signal level.

Red (Reduction)
Shows the degree of reduction or attenuation of the signal.

Out
Displays the level of the resulting output signal.

Controls

Side Chain
N/A

LA (Look Ahead)
With Look Ahead enabled, the input signal being compressed is analysed more
accurately. The compressor uses a little more time to perform its function, but
the resulting treatment is more precise. This implies, however, that the overall
signal is somewhat delayed, and this must be considered in the mix. Maximum
LookAhead times of 4ms and 16ms are available. <Off> disables LookAhead
completely. Keep in mind that LookAhead requires DSP memory. You should
always use the shortest LookAhead time that achieves the desired results and
disable LookAhead when not needed.

Attack
The Attack time is the compressor’s reaction time - the
time it takes it to respond to a level spike. 

Release
This is the time after the signal falls back under the
threshold that compression is no longer active. 

Threshold
Sets the input signal level above which compression begins. 
COMPRESSOR M/S
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Ratio
The Ratio adjusts the compression rate for signals that exceed the threshold
level. The compression is displayed as a relation value. 1:1 means that there is
no compression. 3:1e.g. means that a an amplification of +3dB of the input
signal results only in +1dB at the output.

Gain
A compressor reduces the transient levels of a signal so that the overall signal
can be increased later without danger of distortion. This increases the average
level of the music, resulting in a fuller sound. Adjust the volume increase with
the Gain control.
CONTROLS
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LIMITER M/S
This effect is related to compression and likewise modifies the dynamics of a
sound. It is provided in both a mono and a stereo version. The level of louder
passages is decreased. This means that the overall level of the sound can be set
higher, with the net result that the level of softer sections is increased. The lim-
iter operates by monitoring the level of the input signal. An adjustable
threshold level determines the point at which limiting begins. Attack and
release controls determine how quickly the limiter responds when the
threshold is exceeded and when the input signal level falls back below the
threshold, respectively. The ratio control determines the intensity of the lim-
iting – i.e., the ration of input level change to output level change. The gain
control adjusts the level of the limited signal. The Side Chain In can be used
to permit a signal other than the primary input signal to be used for analysis
and control. The dynamics of the signal appearing at the Side Chain input will
then control the response of the primary audio signal being processed.

Displays

In
Displays the input signal level.

Red (Reduction)
Shows the degree of reduction, or attenuation of the signal.
LIMITER M/S
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Out
Displays the level of the resulting output signal.

Controls

LA (Look Ahead)
With Look Ahead enabled, the input signal being limited is analysed more
accurately. The limiter uses a little more time to perform its function, but the
resulting treatment is more precise. This implies, however, that the overall
signal is somewhat delayed, and this must be considered in the mix. Maximum
LookAhead times of 4ms and 16ms are available. <Off> disables LookAhead
completely.

Keep in mind that LookAhead requires DSP memory. You should always use
the shortest LookAhead time that achieves the desired results and disable
LookAhead when not needed.

Attack
The Attack time (in milliseconds) is the limiter’s reaction
time - the time it takes it to respond to a level spike.

Release
This is the time (in milliseconds) after the signal falls back
under the threshold that limiting is no longer active.

Threshold
Sets the input signal level above which limiting begins.

Ratio
The Ratio adjusts the compression rate for signals that exceed the threshold
level. The compression is displayed as a relation value. 1:1 means that there is
no compression. 3:1e.g. means that a an amplification of +3dB of the input
signal results only in +1dB at the output.

Gain
A limiter reduces the transient levels of a signal so that the overall signal can be
increased later without danger of distortion. This increases the average level of
the music, resulting in a fuller sound. Adjust the volume increase with the Gain
control.
CONTROLS
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GATE M/S
A gate is just what its name says - a gate. When it is open, signals can pass freely.
When closed, signals are blocked. A typical gate will open when a specific
volume threshold is reached, and remain open for a certain specified time. If
the threshold is not reached again during that time, it will close. A gate can
serve several purposes, such as muting the signal to avoid background noise
(noise gate, instrument separation etc.) or to clean up the trailing out of an
instrument sound.

Displays

In
Displays the input level.

Red (Reduction) 
The relative signal reduction is displayed showing the actual working of the
Gate.

Out 
Displays the output level.

Controls

Side Chain
N/A
GATE M/S
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LA (Look Ahead)
With Look Ahead enabled, the input signal being limited is analysed more
accurately. The limiter uses a little more time to perform its function, but the
resulting treatment is more precise. This implies, however, that the overall
signal is somewhat delayed, and this must be considered in the mix. Maximum
LookAhead times of 4ms and 16ms are available. <Off> disables LookAhead
completely.

Keep in mind that LookAhead requires DSP memory. You should always use
the shortest LookAhead time that achieves the desired results and disable
LookAhead when not needed.

Att (Attack) 
Amount of time for full opening of the gate once
the input signal level has exceeded the turn-on
(upper) threshold.

Hold 
Minimum amount of time the gate will stay open
once it is triggered (i.e., minimum delay between
end of attack and start of release).

Rel (Release) 
Amount of time which gate takes to fully close once it begins to close (i.e., once
the input signal level falls below the turn-off (lower) threshold, and after any
remaining hold time has elapsed).

Threshold
Sets the input signal level in dB above which the gate will open. This is the
turn-on (upper) threshold, shown in the display as a yellow point. The turn-
off (lower) threshold is adjusted in tandem with the turn-on threshold, with an
offset determined by the Hyst (hysteresis) control. With the Stereo Gate,
opening of the gate is determined by the louder of the two channels.

Hyst (Hysteresis) 
Adjusts the difference between the turn-on (upper) and turn-off (lower)
thresholds. The turn-off threshold appears as a red point in the display. It can
be set up to 10 dB below the turn-on threshold.
CONTROLS



4-29
Floor 
Sets the level to which gate gain drops when the gate closes. The gate can thus
be set so that it does not close completely.

Gain 
With the Gain control you can increase the Gate output level by up to 18dB.
GATE M/S
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EXPANDER M/S
The Expander influences the dynamics of a sound by making quiet passages
even quieter while leaving other passages alone. Thus the overall dynamic range
of the signal increases. You can use this to alter the way an instrument sound
decays - for example, to alter a looped drum pattern as it fades out, or to blend
undesirable low-level background noise into the signal noise floor. The
Expander is provided in both mono and stereo versions. The Threshold sets the
level at which the effect begins to process the signal. The Attack and Release
controls determine how quickly the effect engages or quits when the threshold
is crossed. Ratio controls the degree of expansion - how much the level is
changed by the effect. The Ratio value indicates the relation of the original
signal to the expanded signal. The Side Chain In can be used to permit a signal
other than the primary input signal to be used for analysis and control. The
dynamics of the signal appearing at the Side Chain input will then control the
response of the primary audio signal being processed.

Displays

In
Displays the input level.

Red (Reduction) 
The relative signal reduction is displayed showing the actual working of the
expander.
DISPLAYS
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Out 
Displays the output level.

Controls

Side Chain
N/A

LA (Look Ahead)
With Look Ahead enabled, the input signal being limited is analysed more
accurately. The expander uses a little more time to perform its function, but
the resulting treatment is more precise. This implies, however, that the overall
signal is somewhat delayed, and this must be considered in the mix. Maximum
LookAhead times of 4ms and 16ms are available. <Off> disables LookAhead
completely.

Keep in mind that LookAhead requires DSP memory. You should always use
the shortest LookAhead time that achieves the desired results and disable
LookAhead when not needed.

Attack
The Attack time (in milliseconds) is the expanders’s reac-
tion time - the time it takes it to respond when the level
falls below the threshold.

Release
This is the time (in milliseconds) after the signal raises
over the threshold that expanding is no longer active.

Threshold
Sets the input signal level below which expanding begins.

Ratio
The Ratio adjusts the compression rate for signals that falls below the threshold
level. The compression is displayed as a relation value. 1:1 means that there is
no expansion. 3:1e.g. means that a an attenuation of -1dB of the input signal
results in -3dB at the output. The maximum Ratio is 10:1.

Gain
The output level of the expander can be adjusted and amplified up to +18dB.
EXPANDER M/S
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DE-ESSER
The De-Esser can eliminate excessive sibilance from voice signals. Only the
undesirable portion of the signal is affected.

Drive
The De-Esser automatically recognizes sibilance signals and therefore requires
only a single control. Drive sets the intensity of the filtering effect. At extreme
settings, even normal “S” sounds may be strongly filtered, lending a lisping
character to spoken words. If this occurs, decrease the Drive setting slightly.
CONTROLS
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LOW CUT M/S
This is a lowpass filter with a 12dB/octave cutoff slope. The filter is provided
in both mono and stereo versions.

Frequency
Sets the filter’s cutoff frequency.
LOW CUT M/S
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HIGH CUT M/S
This is a highpass filter with a 12dB/octave cutoff slope. The filter is provided
in both mono and stereo versions.

Frequency
Sets the filter’s cutoff frequency.
CONTROLS
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DELAY LM/M AND LS/S
The Delay or Echo delays the signal in simple or more complex ways pro-
ducing individual or repeated echoes. Repeated echoes are created using a feed-
back. Filters are included in the feedback loop to damp the high or low
frequencies of subsequent echoes. This effect is provided in versions with large
delays (maximum delay time of 5460 ms), or small delays (maximum of 682
ms.). The stereo versions of the effect also offer the option of switching to a
cross feedback mode.

ms/BPM Mode
Switches between ms Mode (delay time setting in milliseconds) and BPM
Mode (delay time setting in terms of tempo).

BPM (BPM-Mode)
Specify the tempo you wish to match (available range: 25 .. 300 BPM).

Note (BPM-Mode)
Set delay time in terms of a musical note length relative to the BPM (tempo)
setting. P and T indicate “dotted” and “triplet”, respectively. The shortest note
value (delay time) is 1/64T. The longest attainable note value depends upon
the tempo – a slower tempo limits the delay to smaller maximum note values.
If adjustment of BPM causes the maximum delay time (682 ms for Delay M/
S, 5460 ms for Delay LM/LS) to be exceeded, the Note setting is automatically
“stepped down” to the next-largest value.
DELAY LM/M AND LS/S
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Delay (ms-Mode)
Sets delay time directly in milliseconds. The minimum delay setting is 4 ms,
the maximum 682 ms (Delay M/S) or 5460 ms (Delay LM/LS).

FB (Feedback)
Sets the strength of the feedback - the portion of the delayed signal that is
routed back to the input to create multiple receding echoes. The degree of feed-
back determines the fade out time of the repeated echoes.

Cross FB (Cross Feedback, only on Delay S and 
Delay LS)
Cross feedback, when enabled, feeds the signal from the left channel to the
right channel to be delayed, and the signal from the right channel back to the
left. The signal path thus forms a figure eight. When the button is lit, Cross
Feedback is enabled.

LDamp (Low Damp)
Adjusts the amount of low-frequency damping in the feedback loop. Low-fre-
quency damping removes bass tones from the signal with each repeated cycle
through the delay.

HDamp (High Damp)
Adjusts the amount of high-frequency damping in the feedback loop. High-
frequency damping “softens” the signal with each repeat, creating a natural
sounding fade.

Dry
Adjusts the level of the original signal.
MS/BPM MODE
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Wet
Adjusts the level of the effect signal.
DELAY LM/M AND LS/S
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DELAY LCR LS AND S
The LCR Delays produce delayed signals on the left and right channels, and
also in the centre. The delay is adjustable by channel (Left/Right/Centre) and
a feedback loop is included for repeated echo. Filters are included in the feed-
back loop to damp the high or low frequencies of subsequent echoes. This
effect is provided in versions with large delays (maximum delay time of 5460
ms), or small delays (maximum of 682 ms.).

ms/BPM Mode
Switches between ms Mode (delay time setting in milliseconds) and BPM
Mode (delay time setting in terms of tempo).

BPM (BPM-Mode)
Specify the tempo you wish to match (available range: 25 .. 300 BPM).

Note (BPM-Mode)
Set delay time in terms of a musical note length relative to the BPM (tempo)
setting. P and T indicate “dotted” and “triplet”, respectively. The shortest note
value (delay time) is 1/64T. The longest attainable note value depends upon
the tempo – a slower tempo limits the delay to smaller maximum note values.
If adjustment of BPM causes the maximum delay time (682 ms for Delay LCR
S, 5460 ms for Delay LCR LS) to be exceeded, the Note setting is automati-
cally “stepped down” to the next-largest value.
MS/BPM MODE
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Delay (ms-Mode)
Sets delay time directly in milliseconds. The minimum delay setting is 4 ms,
the maximum 682 ms (Delay LCR S) or 5460 ms (Delay LCR LS).

FB (Feedback)
Sets the strength of the feedback - the portion of the delayed signal that is
routed back to the input to create multiple receding echoes. The degree of feed-
back determines the fade out time of the repeated echoes.

Spread
This control adjusts the degree to which the stereo channels are separated in
the stereo image. The centre channel is always in the centre, while the left and
right signals are distributed proportionately in the left and right channels
depending on this setting.

LDamp (Low Damp)
Adjusts the amount of low-frequency damping in the feedback loop. Low-fre-
quency damping removes bass tones from the signal with each repeated cycle
through the delay.

HDamp (High Damp)
Adjusts the amount of high-frequency damping in the feedback loop. High-
frequency damping “softens” the signal with each repeat, creating a natural
sounding fade.

Dry
Adjusts the level of the original signal.

Wet
Adjusts the level of the effect signal. 
DELAY LCR LS AND S
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DUAL DELAY LS AND S
This delay provides the left and right channels with their own independent
feedback loops. Filters are included in the feedback loop to attenuate the high
or low frequencies of subsequent echoes. This effect is provided in versions
with large delays (maximum delay time of 5460 ms), or small delays (max-
imum of 682 ms).

ms/BPM Mode
Switches between ms Mode (delay time setting in milliseconds) and BPM
Mode (delay time setting in terms of tempo).

BPM (BPM-Mode)
Specify the tempo you wish to match (available range: 25 .. 300 BPM).

Note (BPM-Mode)
Set delay time in terms of a musical note length relative to the BPM (tempo)
setting. P and T indicate “dotted” and “triplet”, respectively. The shortest note
value (delay time) is 1/64T. The longest attainable note value depends upon
the tempo – a slower tempo limits the delay to smaller maximum note values.
If adjustment of BPM causes the maximum delay time (682 ms for Dual Delay
S, 5460 ms for Dual Delay LS) to be exceeded, the Note setting is automati-
cally “stepped down” to the next-largest value.

Delay (ms-Mode)
Sets delay time directly in milliseconds. The minimum delay setting is 4 ms,
the maximum 682 ms (Dual Delay S) or 5460 ms (Dual Delay LS).
MS/BPM MODE
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FB L/R (Feedback)
This controls, for each channel, the amount of the delayed signal which will be
fed back to the input to be delayed again. Simply put, the higher this setting,
the more echoes you will get.

LDamp L/R (Low Damp)
Use this control to adjust the amount of low frequency damping in the feed-
back loop for the respective channel.

HDamp (High Damp)
Use this control to adjust the amount of high frequency damping in the feed-
back loop for the respective channel. High-frequency damping “softens” the
signal with each repeat, creating a natural sounding fade.

Dry
Adjusts the level of the original signal.

Wet
Adjusts the level of the effect signal. 
DUAL DELAY LS AND S
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MULTITAP M/S
The Multitap provides four delays with independently adjustable volume, and,
in the stereo version, adjustable pan position as well. The delay is adjustable for
each tap, and a feedback loop is inserted after delay 1 to produce recurring
echoes. Filters are included in the feedback loop to attenuate the high or low
frequencies of subsequent echoes. The maximum delay time for each tap is 682
ms.

ms/BPM Mode
Switches between ms Mode (delay time setting in milliseconds) and BPM
Mode (delay time setting in terms of tempo).

BPM (BPM-Mode)
Specify the tempo you wish to match (available range: 25 .. 300 BPM).

Note (BPM-Mode)
Set delay time in terms of a musical note length relative to the BPM (tempo)
setting. P and T indicate “dotted” and “triplet”, respectively. The shortest note
value (delay time) is 1/64T. The longest attainable note value depends upon
the tempo – a slower tempo limits the delay to smaller maximum note values.
If adjustment of BPM causes the maximum delay time (682 ms) to be
exceeded, the Note setting is automatically “stepped down” to the next-largest
value.
MS/BPM MODE
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Delay 1-4 (ms-Mode)
Sets delay time directly in milliseconds for each of the four taps. The minimum
delay setting is 4 ms, the maximum 682 ms.

FB (Feedback)
Controls the amount of the delayed signal to be fed back to the input to be
delayed again. By skilfully setting individual delay times for each tap, inter-
esting rhythmic effects can be produced when feedback is introduced.

Level 1-4
Adjusts the volume level of each individual tap. Set this to 0 to omit the tap.

Pan 1-4 (only on the Multitap S)
Sets the pan position in the stereo field for each of the four taps

LDamp (Low Damp)
Adjusts the amount of low-frequency damping in the feedback loop. Low-fre-
quency damping removes bass tones from the signal with each repeated cycle
through the delay.

HDamp (High Damp)
Adjusts the amount of high-frequency damping in the feedback loop. High-
frequency damping “softens” the signal with each repeat, creating a natural
sounding fade.

Dry
Adjusts the level of the original signal.

Wet
Adjusts the level of the effect signal.
MULTITAP M/S
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DUCKING DELAY M/S
The Ducking Delay unites a Ducker and a Delay in a single effect which is
especially useful for processing vocals (but can of course be used with instru-
ments as well). The main and side-chain inputs of the Ducker are connected
to the delay output and the dry signal, respectively. During vocal passages, the
delay effect is partially or entirely faded out, and returns during the pauses
between vocal passages. The familiar Attack, Release and Threshold controls
adjust the speed and intensity of the attenuation. Both a mono and a stereo ver-
sion are provided.

Displays

In
Displays the input signal level.

Red (Reduction)
Shows the degree of reduction, or attenuation of the delay signal.

Out
Displays the level of the resulting output signal.
DISPLAYS
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Controls

ms/BPM Mode
Switches between ms Mode (delay time setting in milliseconds) and BPM
Mode (delay time setting in terms of tempo).

BPM (BPM-Mode)
Specify the tempo you wish to match (available range: 25 .. 300 BPM).

Note (BPM-Mode)
Set delay time in terms of a musical note length relative to the BPM (tempo)
setting. P and T indicate “dotted” and “triplet”, respectively. The shortest note
value (delay time) is 1/64T. The longest attainable note value depends upon
the tempo – a slower tempo limits the delay to smaller maximum note values.
If adjustment of BPM causes the maximum delay time (682 ms) to be
exceeded, the Note setting is automatically “stepped down” to the next-largest
value.

Delay (ms-Mode)
Sets delay time directly in milliseconds. The minimum delay setting is 4 ms,
the maximum 682 ms.

FB (Feedback)
Sets the strength of the feedback - the portion of the delayed signal that is
routed back to the input to create multiple receding echoes. The degree of feed-
back determines the fade out time of the repeated echoes.
DUCKING DELAY M/S
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Cross FB (Cross Feedback, only on Ducking 
Delay S)
Cross feedback, when enabled, feeds the signal from the left channel to the
right channel to be delayed, and the signal from the right channel back to the
left. The signal path thus forms a figure eight. When the button is lit, Cross
Feedback is enabled.

LDamp (Low Damp)
Adjusts the amount of low-frequency damping in the feedback loop. Low-fre-
quency damping removes bass tones from the signal with each repeated cycle
through the delay.

HDamp (High Damp)
Adjusts the amount of high-frequency damping in the feedback loop. High-
frequency damping “softens” the signal with each repeat, creating a natural
sounding fade.

Attack
Adjusts the amount of time over which the delay output signal is faded down
when the input signal crosses the threshold.

Release
Adjusts the amount of time over which the delay output signal is faded back
up when the input signal level falls back below the threshold.

Threshold
Sets the side-chain signal level at which attenuation of the delay output begins.
As the side-chain signal level increases further, the delay output is increasingly
attenuated according to the setting of the Ratio control.
CONTROLS
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Ratio
Controls ducking “intensity”. Sets the rate of increase of delay output attenu-
ation as the side-chain signal level increases beyond the level specified by the
Threshold setting. At the maximum setting of inf:1, the delay output is atten-
uated by exactly the amount by which the side-chain signal level exceeds the
threshold. For example, with Threshold set to -30 dB, the delay output will be
attenuated by a maximum of 30 dB when the side-chain signal level is at its
maximum level of 0 dB, with correspondingly less attenuation at lower side-
chain signal levels. Intermediate Ratio settings yield smaller maximum attenu-
ation values – at the minimum setting of 1:1, no attenuation occurs and the
delay output signal comes through at its full actual level.

Ducking On/Off
Deactivates the Ducker, so that a normal delay effect is obtained.

Dry
Adjusts the level of the original signal.

Wet
Adjusts the level of the effect signal.
DUCKING DELAY M/S
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PATTERN DELAY
This delay permits easy creation of rhythmic delays and loops. Delay times are
set via a pattern editor which displays the 16th-intervals of a bar (or the triplet
version of same). The pattern is repeated over the course of the interval speci-
fied under Loop. Volume level and pan position can be set per delay. The low-
pass and high-pass filters provided are located within the pattern feedback
path. The effect functions in stereo.

Loop
Sets the time interval over which the overall pattern is repeated or restarted.
This setting is specified in terms of note-length values and can be shorter than
the pattern itself if desired. In fact, this control is the delay time setting for a
separate, “hidden” looping delay around which the feedback occurs. The
output signal from this delay, combined with the dry input signal, is fed to the
inputs of pattern delays 1-4, whose lengths can therefore be longer than the
Loop setting.

Delay On/Off 1-4
Each button switches the corresponding delay tap on or off. Switching a delay
off removes it from the pattern. A delay is active when the corresponding
button is lit.
CONTROLS
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Delay Length 1-4
The delay time of a tap is specified in terms of note intervals which can be set
within the displayed grid. The individual positions in the grid represent either
16ths or triplets, depending upon whether the Triplets option is selected (see
below). The white boxes indicate quarter-note positions in either case.

Note that the outputs of delays 1-4 are not included in the feedback loop!

Triplets
Switches the pattern to triplets mode. The individual boxes in the pattern grid
now represent triplets instead of “straight” sixteenths. Triplets is activated
when the button is lit.

Level 1-4
These controls adjust the volume levels of the individual taps. Set a level con-
trol to zero to exclude the corresponding tap.

Pan 1-4
These controls adjust the pan positions of the individual taps.

Tempo
Enter any desired tempo between 25 and 300 BPM.

FB (Feedback)
Adjusts the amount of looping delay output signal which is fed back to the
delay inputs, where it is again looped and repeated as a pattern. At typical feed-
back settings, the repeating echoes decrease in volume with each additional
pass through the delay. When this control is set to maximum, signals fed into
the delay line will be repeated infinitely.

LDamp (Low Damp)
Adjusts the amount of low-frequency damping in the feedback loop. Low-fre-
quency damping removes bass tones from the signal with each repeated cycle
through the delay.

HDamp (High Damp)
Adjusts the amount of high-frequency damping in the feedback loop. High-
frequency damping “softens” the signal with each repeat, creating a natural
sounding fade.
PATTERN DELAY
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Dry
Adjusts the level of the original signal.

Wet
Adjusts the level of the effect signal.
CONTROLS
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DISTORTION M/S
This effect produces both “soft” or “hard” distortion. Soft distortion is compa-
rable to that which results when analog magnetic tape overload occurs – it
comes on slowly with increasing signal level and has a soft sound. Hard distor-
tion is produced via simple clipping. It appears more suddenly and has a
harder, edgier sound. This module can be used polyphonically as well as mono-
phonically – thus both before and after the Poly Out module. Since the overall
signal level increases when you use the Gain control to raise the distortion level,
a Level control is provided to attenuate the signal for output.

Gain
Controls the amount of distortion. The level of the overall signal is also
increased along with the distortion.

Hard
When Hard is enabled, the signal is digitally clipped (cut off). Hard is enabled
when the button is lit.

Soft
This distortion effect emulates that of an overdriven analog tape machine. It is
a gentler form of distortion than hard clipping. Soft is enabled when the button
is lit.

Level
This control allows you to compensate for the increase in signal volume when
distortion is added.
DISTORTION M/S
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TDRIVE M/S AND TQDRIVE M/S
This effect simulates the warm, rich sound of the distortion produced by a tube
amplifier (hence the “T” in the name). Filters permit further tonal shaping.
The TQDrive has one pre-distortion EQ and two post-distortion EQs. Both
effects are provided in mono and stereo versions.

Drive
Controls the degree of distortion. The distortion circuit also boosts the signal
level. The green and red LEDs next to the text field indicate whether a signal
is present and whether digital clipping (overload) is occurring. Clipping can be
avoided by adjusting Level.

Level
Permits level trimming to avoid digital clipping. If digital clipping occurs (as
indicated by the red LEDs), turn Level down until only the green LEDs are lit.
If reducing Level does not eliminate the clipping, reduce Drive slightly as well.

LCut (Lowcut)
Use this control to limit the distortion to the higher frequencies.

HDamp (High Damp)
Decreases the level of the high frequencies, producing a warmer, “rounder” dis-
tortion sound.

Spread (TDrive S and TQDrive S only)
A short delay to produce a broader stereo image.

Pre and Post-EQs 

Frequency
Adjusts the filter’s centre frequency.
PRE AND POST-EQS
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Q
Sets the filter's quality, or Q factor. This determines the width of the frequency
band which the filter will affect.

Gain
Adjusts the filter band’s cut or boost level in dB.
TDRIVE M/S AND TQDRIVE M/S
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AUTOWAH M/S
This effect combines the TDrive distortion effect (see preceding section) with
a multimode filter whose cutoff frequency is controlled by an envelope fol-
lower. The envelope follower follows the level of the original (pre-distortion)
signal, since the distortion effect “flattens out” the signal dynamics. When the
filter resonance is turned up, the sounds produced resemble the words “wah-
wah”, hence the name of the effect. A mono and a stereo version of the effect
are provided.

Drive
Controls the degree of distortion. The distortion circuit also boosts the signal
level. The green and red LEDs next to the text field indicate whether a signal
is present and whether digital clipping (overload) is occurring. Clipping can be
avoided by adjusting Level.

Level
Permits level trimming to avoid digital clipping. If digital clipping occurs (as
indicated by the red LEDs), turn Level down until only the green LEDs are lit.
If reducing Level does not eliminate the clipping, reduce Drive slightly as well.

LCut (Lowcut)
Use this control to limit the distortion to the higher frequencies.

HDamp (High Damp)
Decreases the level of the high frequencies, producing a warmer, “rounder” dis-
tortion sound.
PRE AND POST-EQS



4-55
Envelope Follower

Gain
Some signal levels are too low or too high to be processed effectively. Adjust
the Gain control up or down to Optimise the signal level.

Attack
Controls the response time of the envelope follower to rising levels of the audio
signal.

Decay
Controls the response time of the envelope follower to falling levels of the
audio signal.

Filter

Filter Type
High-pass, low-pass and band-pass modes can be selected. The filter slope is 12
dB/octave in all modes.

Frequency
Sets filter cutoff or centre frequency, with the current value displayed in Hz.

Resonance
Sets the amount of filter resonance. Values between 0 and 127 are displayed
for reference.

Env Follower
Controls the amount of filter frequency modulation produced by the envelope
follower. Negative values produce an inverse modulation.
AUTOWAH M/S
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CHORUS S AND HARMONIC CHORUS S
The name “chorus” hints at the sound produced by this effect. It spreads and
thickens the sound passed through it, simulating the sound of multiple instru-
ments of the same type playing together – in other words, a chorus. This effect
is achieved by means of a short delay line whose delay time is periodically mod-
ulated. Mixing of this delayed signal with the original produces the chorus
effect. The intensity of the effect depends upon the modulation rate, depth and
phase settings as well as the dry/wet (original/delayed) mix. Adjustable feed-
back and cross feedback controls are also provided. The effect is also useful for
creating a stereo sound from a monaural signal.

The Harmonic Chorus splits the signal into two frequency ranges and applies
the effect only to frequencies above the split frequency.

Rate
Adjusts the frequency of delay time modulation in the chorus effect.

Depth
Adjusts the amount of delay time modulation in the chorus effect, and thus its
intensity.

FB (Feedback)
Controls the level of the feedback signal which produces the comb filter effect,
similar to flanging. Negative feedback values invert the phase of the feedback
signal, changing the sound of the comb filter effect accordingly.
FILTER
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Cross FB (Cross Feedback)
When Cross FB is enabled, the left and right feedback signals are cross-routed
to the right and left delay line inputs respectively. This creates comb filter
effects which differ from those obtained with simple feedback. When the
button is lit, Cross FB is enabled.

L/R Phase
Adjusts the phase difference between the modulation signals applied to the left
and right channels. This influences the apparent “breadth” of the stereo image. 

Split F (Split Freq, only on Harm. Chorus S)
Sets the frequency at which the original signal is split into two frequency
ranges. Only the frequencies above the split frequency will be processed for the
chorus effect.

LowL (Low Level, only on Harm. Chorus S)
Adjusts the volume level of the portion of the signal lying below the split fre-
quency. This part of the signal is not processed for the chorus effect.

HighL (High Level, only on Harm. Chorus S)
Adjusts the volume level of the portion of the signal lying above the split fre-
quency. This is the part of the signal that is processed for the chorus effect.

Dry
Adjusts the level of the original signal.

Wet
Adjusts the level of the signal after processing by the chorus effect.

Make sure there is always some of the wet component added to the dry signal.
Otherwise the effect will not be apparent.
CHORUS S AND HARMONIC CHORUS S
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MASTER CHORUS M/S
This sophisticated device offers options for modifying modulation and chorus
tone colour, in addition to the classic chorus parameters. It covers a wide range
of sounds, from especially subtle chorusing to intense chorusing with feedback.
Both mono and stereo versions are provided.

PreDel L/R
Adjusts the delay time over the range of 0 to 100 msec for both channels of the
integrated stereo delay line which is connected in-line ahead of the chorus
effect.

Waveform
Selects either a sine or triangle waveform for modulation of the chorus effect.

Shape
“Warps” the modulation waveform, widening the dips and narrowing the
peaks to an adjustable degree, thereby altering the “motion” produced by the
modulation.

Rate
Adjusts the frequency of delay time modulation in the chorus effect.

Depth
Adjusts the amount of delay time modulation in the chorus effect, and thus its
intensity.
FILTER
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FB (Feedback)
Controls the level of the feedback signal which produces the comb filter effect,
similar to flanging. Negative feedback values invert the phase of the feedback
signal, changing the sound of the comb filter effect accordingly.

L/R Phase (MasterChorus S only)
Adjusts the phase difference between the modulation signals applied to the left
and right channels. This influences the apparent “breadth” of the stereo image.

LoDamp (Low Damp)
Adjusts the amount of low-frequency damping in the feedback loop.

HiDamp (High Damp)
Adjusts the amount of high-frequency damping in the feedback loop.

Through the simultaneous use of both filters, the comb filter effect produced
via feedback can be restricted to specific frequencies.

Dry
Adjusts the level of the original signal.

Wet
Adjusts the level of the signal after processing by the chorus effect.

Make sure there is always some of the wet component added to the dry signal.
Otherwise the effect will not be apparent.
MASTER CHORUS M/S
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HEXA CHORUS S
The Hexa Chorus taps the signal not just once, but six times, to provide mul-
tiple delayed signals for the chorus effect. Each signal can be modulated for a
particularly full and rich sound.

The Hexa Chorus S also features an integrated stereo delay with independently
adjustable delay times for each channel.

PreDel (Left/Right)
Adjusts the integrated delay for both of the stereo channels. The range is from
0 to 628 ms.

Rate
Adjusts the frequency of delay time modulation in the chorus effect.

Depth
Adjusts the amount of delay time modulation in the chorus effect, and thus its
intensity.

Stereo Spread
Controls the distribution of the effect signals between the two stereo channels.
At the minimum value, the signals are mixed and sent equally to each channel.
At the maximum value, the signals are sent individually to each channel, cre-
ating a quasi stereo effect.

Dry
Adjusts the level of the original signal.
FILTER
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Wet
Adjusts the level of the signal after processing by the effect.

Make sure there is always some of the wet component added to
the dry signal. Otherwise the effect will not be apparent.
HEXA CHORUS S
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4TAP CHORUS S
This effect features four independent delays with separately adjustable delay
time (0 -682ms), volume and pan position. A feedback path from the Delay 1
output can produce recurring echoes. A filter is included in the feedback loop
to attenuate the high frequency content of subsequent echoes. Each delay is fol-
lowed by a chorus effect.

Delay Time Tap 1-4
These controls adjust the delay for each of the four taps individually within a
range of 0 - 682 ms.

Level 1-4
Level controls for the individual taps. Set a control to 0 to eliminate the corre-
sponding tap from the effect.

Pan 1-4
Adjusts the position of each tap in the stereo field.

Feedback
Adjusts the amount of Delay 1 output signal being fed back to the input. By
skilfully setting individual delay times for each tap, rhythmic effects can be pro-
duced when feedback is introduced.
FILTER
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High Damp
Adjusts the amount of high-frequency damping in the feedback loop. High-
frequency damping “softens” the signal with each repeat, creating a natural
sounding fade.

LFO
Selects between triangle (Tri) and sine as the LFO waveform for delay time
modulation in the chorus effect. Rate Adjusts the frequency of delay time mod-
ulation in the chorus effect.

Depth
Adjusts the amount of delay time modulation in the chorus effect, and thus its
intensity. 

Dry 
Adjusts the level of the original signal. 

Wet
Adjusts the level of the signal after processing by the effect.

Make sure there is always some of the wet component added to
the dry signal. Otherwise the effect will not be apparent.
4TAP CHORUS S
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FLANGER M/S, HARMONIC FLANGER S
This effect is similar to the chorus. Like the chorus, a flanger is based on a delay
line whose delay time is periodically modulated. However, the delay times in a
flanger are substantially shorter than those of a chorus. In addition, the flanger
utilizes feedback of the delayed signal back to the delay line input. Therefore,
it not only thickens the sound but can add noticeable coloration owing to the
comb-filter effect which results from the feedback. The intensity of the effect
depends upon the modulation rate, depth and phase settings as well as the dry/
wet (original/delayed) mix. The effect is provided in both mono and stereo ver-
sions and is also useful for creating a stereo sound from a monaural signal.

The Harmonic Flanger splits the signal into two frequency ranges, and applies
the effect only to the frequencies above the split frequency.

Rate
Adjusts the frequency of delay time modulation in the flanger effect.

Depth
Adjusts the amount of delay time modulation in the flanger effect, and thus its
intensity.

FB (Feedback)
Controls the level of the feedback signal which produces the comb filter effect.
Negative feedback values invert the phase of the feedback signal, changing the
sound of the comb filter effect accordingly.
FILTER
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Cross FB (Cross Feedback, only on Flanger S 
and Harmonic Flanger S)
When Cross FB is enabled, the left and right feedback signals are cross-routed
to the right and left delay line inputs respectively. This creates comb filter
effects which differ from those obtained with simple feedback. When the
button is lit, Cross FB is enabled.

L/R Phase (only on Flanger S and H. Flanger S)
Adjusts the phase difference between the modulation signals applied to the left
and right channels. This influences the apparent “breadth” of the stereo image.

Split F (Split Frequency, only on Harm. Flanger 
S)
Sets the frequency at which the original signal is split. Only the frequencies
above the split frequency are processed via the flanger effect.

LowL (Low Level, only on HarmonicFlanger S)
Adjusts the volume level of the portion of the signal lying below the split fre-
quency. This part of the signal is not processed via the flanger effect.

HighL (HighLevel, only on Harm. Chorus S)
Adjusts the volume level of the portion of the signal lying above the split fre-
quency. This part of the signal is processed via the flanger effect.

Dry
Adjusts the level of the original signal.

Wet
Adjusts the level of the processed signal.

Make sure there is always some of the wet component added to the dry signal.
Otherwise the effect will not be apparent.
FLANGER M/S, HARMONIC FLANGER S
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MASTER FLANGER M/S
This sophisticated device offers options for modifying modulation and flanger
tone colour, in addition to the classic flanger parameters. It covers a wide range
of sounds, from subtle flanging to intense flanging with feedback. Both mono
and stereo versions are provided.

PreDel L/R
Adjusts the delay time over the range of 0 to 100 msec for both channels of the
integrated stereo delay line which is connected in-line ahead of the flanger
effect.

Waveform
Selects either a sine or triangle waveform for modulation of the flanger effect.

Shape
“Warps” the modulation waveform, widening the dips and narrowing the
peaks to an adjustable degree, thereby altering the “motion” produced by the
modulation.

Rate
Adjusts the frequency of delay time modulation in the flanger effect.

Depth
Adjusts the amount of delay time modulation in the flanger effect, and thus its
intensity.
FILTER
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FB (Feedback)
Controls the level of the feedback signal which produces the typical flanger
comb filter effect. Negative feedback values invert the phase of the feedback
signal, changing the sound of the comb filter effect accordingly.

L/R Phase (MasterFlanger S only)
Adjusts the phase difference between the modulation signals applied to the left
and right channels. This influences the apparent “breadth” of the stereo image.

LoDamp (Low Damp)
Adjusts the amount of low-frequency damping in the feedback loop.

HiDamp (High Damp)
Adjusts the amount of high-frequency damping in the feedback loop.

Through the simultaneous use of both filters, the comb filter effect produced
via feedback can be restricted to specific frequencies.

Dry
Adjusts the level of the original signal.

Wet
Adjusts the level of the signal after processing by the chorus effect.

Make sure there is always some of the wet component added to
the dry signal. Otherwise the effect will not be apparent.
MASTER FLANGER M/S
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RANDOM FLANGER M/S
The sound of this effect is similar to that of the Master Flanger. However, the
modulation waveform is a random signal, resulting in an effect which varies
continuously in intensity and character. Both mono and stereo versions are
provided.

PreDel L/R
Adjusts the delay time over the range of 0 to 100 msec for both channels of the
integrated stereo delay line which is connected in-line ahead of the flanger
effect.

Waveform
Selects a sine, triangle or stepped waveform for modulation of the flanger
effect. The amplitude of the selected waveform varies randomly.

Rate
Adjusts the frequency of delay time modulation in the flanger effect.

Depth
Adjusts the amount of delay time modulation in the flanger effect, and thus its
intensity.
FILTER
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FB (Feedback)
Controls the level of the feedback signal which produces the typical flanger
comb filter effect. Negative feedback values invert the phase of the feedback
signal, changing the sound of the comb filter effect accordingly.

L/R Phase (RandomFlanger S only)
Selects between in-phase (0°) and out-of-phase (180°) modulation signals for
the left and right channels of the flanger effect. This influences the apparent
“breadth” of the stereo image.

LoDamp (Low Damp)
Adjusts the amount of low-frequency damping in the feedback loop.

HiDamp (High Damp)
Adjusts the amount of high-frequency damping in the feedback loop.

Through the simultaneous use of both filters, the comb filter effect produced
via feedback can be restricted to specific frequencies.

Dry
Adjusts the level of the original signal.

Wet
Adjusts the level of the signal after processing by the chorus effect.

Make sure there is always some of the wet component added to
the dry signal. Otherwise the effect will not be apparent.
RANDOM FLANGER M/S
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SPACE FLANGER M/S
In this flanger, not only the delay position is varied, but the delay length as
well. This lends the Space Flanger a very distinctive character. Both mono and
stereo versions are provided.

PreDel L/R
Adjusts the delay time over the range of 0 to 100 msec for both channels of the
integrated stereo delay line which is connected in-line ahead of the flanger
effect.

Waveform
Selects either a sine or triangle waveform for modulation of the flanger effect.

Shape
“Warps” the modulation waveform, widening the dips and narrowing the
peaks to an adjustable degree, thereby altering the “motion” produced by the
modulation.

Rate
Adjusts the frequency of delay time modulation in the flanger effect.

Depth
Adjusts the amount of delay time modulation in the flanger effect, and thus its
intensity.
FILTER
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FB (Feedback)
Controls the level of the feedback signal which produces the typical flanger
comb filter effect. Negative feedback values invert the phase of the feedback
signal, changing the sound of the comb filter effect accordingly.

L/R Phase (Space Flanger S only)
Adjusts the phase difference between the modulation signals applied to the left
and right channels. This influences the apparent “breadth” of the stereo image.

LoDamp (Low Damp)
Adjusts the amount of low-frequency damping in the feedback loop.

HiDamp (High Damp)
Adjusts the amount of high-frequency damping in the feedback loop.

Through the simultaneous use of both filters, the comb filter effect produced
via feedback can be restricted to specific frequencies.

Dry
Adjusts the level of the original signal.

Wet
Adjusts the level of the signal after processing by the chorus effect.

Make sure there is always some of the wet component added to
the dry signal. Otherwise the effect will not be apparent.
SPACE FLANGER M/S
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STEP FLANGER M/S
The Step Flanger applies a sample-and-hold circuit to the modulation wave-
form. The resulting flanger effects range from a step-wise movement of the
comb filter through its spectrum to abrupt large jumps. Both mono and stereo
versions are provided.

PreDel L/R
Adjusts the delay time over the range of 0 to 100 msec for both channels of the
integrated stereo delay line which is connected in-line ahead of the flanger
effect.

Waveform
Selects either a sine or triangle waveform for modulation of the flanger effect.

Shape
“Warps” the modulation waveform, widening the dips and narrowing the
peaks to an adjustable degree, thereby altering the “motion” produced by the
modulation.

Rate
Adjusts the frequency of delay time modulation in the flanger effect.
SHAPE
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Depth
Adjusts the amount of delay time modulation in the flanger effect, and thus its
intensity.

Step Rate
Adjusts the rate at which the modulation signal is “chopped” into steps by the
sample-and-hold circuit. Specified as a multiple of the modulation frequency.
For typical staircase effects, the step rate should be at least twice the modula-
tion rate.

Step Lag
Adjusts the rate at which the modulation signal slews, or makes its transition,
from one step value to the next. Larger settings produce more gradual transi-
tions, while a setting of zero yields very hard transitions.

FB (Feedback)
Controls the level of the feedback signal which produces the typical flanger
comb filter effect. Negative feedback values invert the phase of the feedback
signal, changing the sound of the comb filter effect accordingly.

L/R Phase (Step Flanger S only)
Adjusts the phase difference between the modulation signals applied to the left
and right channels. This influences the apparent “breadth” of the stereo image.

LoDamp (Low Damp)
Adjusts the amount of low-frequency damping in the feedback loop.

HiDamp (High Damp)
Adjusts the amount of high-frequency damping in the feedback loop.

Through the simultaneous use of both filters, the comb filter effect produced
via feedback can be restricted to specific frequencies.

Dry
Adjusts the level of the original signal.

Wet
Adjusts the level of the signal after processing by the chorus effect.

Make sure there is always some of the wet component added to the dry signal.
Otherwise the effect will not be apparent.
STEP FLANGER M/S
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PHASER M/S
The phaser or phase-shifter is similar to the flanger and chorus, but instead of
using a delay line, it functions by introducing frequency-dependent phase
shifts into the signal which is passed through it. The key phase-shift frequen-
cies, and therefore the amount of phase shift, are periodically modulated. The
phase-shifter effect results when this phase-manipulated signal is mixed with
the original signal. The effect is thus similar to the flanger and chorus, but with
a sound character of its own. The intensity of the effect depends upon the mod-
ulation rate, depth and phase settings as well as the dry/wet (original/phase-
shifted) mix. The effect is provided in both mono and stereo versions and is
also useful for creating a stereo sound from a monaural signal.

Rate
Controls the frequency of the phase modulation of the Phaser.

Depth
Adjusts the modulation depth - the strength of the phase modulation.

FB (Feedback)
Controls the level of the feedback signal which intensifies the typical phasing
effect. Negative feedback values invert the phase of the feedback signal,
changing the sound of the phaser accordingly.

Cross FB (only on Phaser S)
When Cross FB is enabled, the left and right feedback signals are cross-routed
to the right and left phase filter inputs respectively. This creates effects which
differ from those obtained with simple feedback. When the button is lit, Cross
FB is enabled.
SHAPE
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L/R Phase (only on Phaser S)
Adjusts the phase difference between the modulation signals applied to the left
and right channels. This influences the apparent “breadth” of the stereo image.

Dry
Adjusts the level of the original signal. 

Wet
Adjusts the level of the processed signal.

Make sure there is always some of the wet component added to
the dry signal. Otherwise the effect will not be apparent.
PHASER M/S
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WHAT IS SSB?
SSB is an abbreviation for Single Side-Band and refers to a modulation process
by means of which a signal's frequencies can be shifted. The shift is the same
for all frequencies – for example, if a signal contains components at 440 Hz,
880 Hz, 1760 Hz and 3520 Hz, an SSB modulator can shift each of these fre-
quencies by +10 Hz to 450 Hz, 890 Hz, 1770 Hz and 3530 Hz. Therefore,
SSB is also referred to as frequency shifting or spectrum shifting. Until now,
SSB has been available only in expensive modular systems such as the Moog
Modular.

Frequency shifting is not to be confused with pitch shifting. In pitch shifting,
all frequencies are multiplied by the same factor (or, in other words, trans-
posed) and harmonic relationships are preserved.

With SSB, by contrast, harmonic relationships are as a rule transformed into
inharmonic ones, as the above example illustrates: whereas 880 Hz is an octave
above 440 Hz, 890 Hz is not an octave above 450 Hz – the shifted frequencies
are no longer harmonically related.
SHAPE
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SSB PHASER M/S
If SSB is used to shift a signal's frequency spectrum only slightly (by less than
1 Hz), and if the shifted signal is mixed with the original, an effect is produced
which is not unlike a phaser, but which differs significantly from a phaser in
the following respect: whereas a phaser creates phase-cancellations which move
up and down through the frequency spectrum, those produced by an SSB
phaser move only in one direction, according to the sign of the spectrum shift
(plus or minus). Larger shifts produce spectra and sounds similar to those pro-
duced by ring modulation. Both mono and stereo versions of the SSB Phaser
are provided.

Frequency Shift
Amount by which all frequencies in the signal spectrum are shifted. Both pos-
itive and negative shifts are possible. 

Range
Multiplier for the Frequency Shift control – sets its effective range. 1.00000x
permits a shift of -/+24000 Hz, while 0.00001x produces a range of -/+ 0.2400
Hz. By setting Range appropriately, Frequency Shift can be adjusted very
finely.

Feedback
Feedback causes the processed signal to be processed over and over again. An
already-shifted frequency gets shifted again and again by the same amount.
With small frequency shift amounts, this intensifies the phasing effect, while
with large shifts, generation of more inharmonic components is the result.
SSB PHASER M/S
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Dry On/Off
Switches the dry (unprocessed) signal on or off. Switch it off when you want
to use only the frequency shifter. The dry signal is present when the button is
lit.

Link Shifts (SSB Phaser S only)
When this function is activated, the frequency shift can be set simultaneously
for both left and right signals.

Dry
Adjusts the level of the original signal.

Wet
Adjusts the level of the SSB effect signal.
SHAPE
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SSB MODULATOR M/S
This effect is the same as the SSB Phaser, but with the additional ability to
modulate the frequency shift via an LFO. Waveform, depth and rate of the
LFO are adjustable. The LFO signal is summed with the Frequency Shift set-
ting to produce the total shift. Both mono and stereo versions of the effect are
provided.

Frequency Shift
Amount by which all frequencies in the signal spectrum are shifted. Both pos-
itive and negative shifts are possible. 

LFO Depth
Sets the maximum amount of frequency shift produced by the LFO. Both pos-
itive and negative shifts are possible. 

Range
Multiplier for the Frequency Shift control – sets its effective range. 1.00000x
permits a shift of -/+24000 Hz, while 0.00001x produces a range of -/+ 0.2400
Hz. By setting Range appropriately, Frequency Shift can be adjusted very
finely.

Feedback
Feedback causes the processed signal to be processed over and over again. An
already-shifted frequency gets shifted again and again by the same amount.
With small frequency shift amounts, this intensifies the phasing effect, while
with large shifts, generation of more inharmonic components is the result.
SSB MODULATOR M/S
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LFO Wave
Sets the LFO waveform used for frequency shift modulation. Choices include
Sine, Square, Saw Up, Saw Down, Triangle and Random.

Rate
Sets the rate of LFO frequency shift modulation.

Dry On/Off
Switches the dry (unprocessed) signal on or off. Switch it off when you want
to use only the frequency shifter. The dry signal is present when the button is
lit.

Link Shifts (SSB Modulator S only)
When this function is activated, the frequency shift can be set simultaneously
for both left and right signals.

Dry
Adjusts the level of the original signal.

Wet
Adjusts the level of the SSB effect signal.
SHAPE
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SSB DELAY M/S
This effect combines frequency shifting and delay. The frequency shifting is
done in the feedback path of the delay. The signal frequency spectrum thus ini-
tially remains unaltered, but is shifted further and further with each succeeding
echo. Both mono and stereo versions of the effect are provided.

Frequency Shift
Amount by which all frequencies in the signal spectrum are shifted. Both pos-
itive and negative shifts are possible. 

Range
Multiplier for the Frequency Shift control – sets its effective range. 1.00000x
permits a shift of -/+24000 Hz, while 0.00001x produces a range of -/+ 0.2400
Hz. By setting Range appropriately, Frequency Shift can be adjusted very
finely.

ms/BPM Mode
Switches between ms Mode (delay time setting in milliseconds) and BPM
Mode (delay time setting in terms of tempo).

BPM (BPM-Mode)
Specify the tempo you wish to match (available range: 25 .. 300 BPM).
SSB DELAY M/S



4-82
Note (BPM-Mode)
Set delay time in terms of a musical note length relative to the BPM (tempo)
setting. P and T indicate “dotted” and “triplet”, respectively. The shortest note
value (delay time) is 1/64T. The longest attainable note value depends upon
the tempo – a slower tempo limits the delay to smaller maximum note values.
If adjustment of BPM causes the maximum delay time (682 ms for Delay M/
S, 5460 ms for Delay LM/LS) to be exceeded, the Note setting is automatically
“stepped down” to the next-largest value.

Delay (ms-Mode)
Sets delay time directly in milliseconds. The minimum delay setting is 4 ms,
the maximum 5460 ms.

FB (Feedback)
Sets the strength of the feedback - the portion of the delayed signal that is
routed back to the input to create multiple receding echoes. The degree of feed-
back determines the fade out time of the repeated echoes – or, somewhat over-
simplified, the number of echoes.

Cross FB (Cross Feedback, SSB Delay S only)
When Cross FB is enabled, the left and right feedback signals are cross-routed
to the right and left delay line inputs respectively. This creates more complex
frequency shifting effects than those obtained with simple feedback. When the
button is lit, Cross FB is enabled.

LDamp (Low Damp)
Adjusts the amount of low-frequency damping applied to a signal per pass
through the feedback loop.

HDamp (High Damp)
Adjusts the amount of high-frequency damping applied to a signal per pass
through the feedback loop.
SHAPE
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PITCH SHIFTER M/S
Use the Pitch Shifter to change the pitch of a signal without altering its dura-
tion. The pitch shifter can be used to produce a second voice at an adjustable,
fixed interval from the original signal. With the stereo version, the pitch for
each channel can be independently adjusted, as well as the volume and pan
position. The mono version includes a delay you can apply to the pitch shifted
signal.

Coarse (L / R)
Adjusts the detune value in half-tones. Note that high values here require you
to use a correspondingly high Time Range setting for a clean-sounding result.

Fine (L/R)
Adjusts the detune value in very fine increments. The range is +/- 99 cents,
where a cent is 1/100th of a half-tone (1/2 tone = 100 cents).

Level L/R (only in Pitch Shifter S)
Controls the volume level of the effect signal.

Pan L/R (only in Pitch Shifter S)
Controls the left/right positioning of the effect signal in the stereo field.

Delay (only in Pitch Shifter M)
Controls the delay of the effect signal. The range is from 0 - 2000 ms.
PITCH SHIFTER M/S
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Feedback (only in Pitch Shifter M)
This controls, for each channel, the amount of the delayed signal which will be
fed back to the input to be delayed again. Simply put, the higher this setting,
the more echoes you will get.

High Damp
Use this control to adjust the amount of low frequency damping in the feed-
back loop for the respective channel.

Time Range
This control influences the quality of the effect. The optimal value depends on
the nature of the raw material, so you should experiment with it somewhat. In
general, the larger the value, the more exact the calculation, although it may
take longer.

LFO Modulation

Frequency
You can modulate the pitch with an LFO. This controls the frequency of the
LFO, or the rate of the modulation.

Mod Depth
Controls the depth of the pitch modulation.

Dry
Adjusts the level of the original signal.

Wet
Adjusts the level of the signal after processing by the effect.

Make sure there is always some of the wet component added to the dry signal.
Otherwise the effect will not be apparent.
LFO MODULATION
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4-POLE FILTER M/S
This 4-Pole Filter is a lowpass filter with adjustable resonance which can be
periodically modulated. Use this filter to create outstanding periodic filter
effects. Two versions of the filter are provided, a Mono-Insert and a Stereo-
Insert. The functionality of the two is identical. You can adjust the filter
quickly and intuitively by direct graphic editing. Adjust the cutoff frequency
by moving the mouse horizontally while holding the (left in PC version) mouse
button. Adjust the resonance by moving the mouse vertically with the right
button pressed (‘Ctrl’ + mouse button in the Mac version).

Freq
Adjusts the lowpass filter’s cutoff frequency.

Res (Resonance)
Strength of the filter resonance.

LFO Wave
Several waveforms are available to be used by the integrated LFO for cutoff fre-
quency modulation. Select the waveform using the arrow keys, or by clicking
on the display area and moving the mouse on or off. The following waveforms
can be selected: Sine, Rectangle, Saw up, Saw down, Triangle, Rectangle with
variable pulsewidth.

LFO On/Off
Use the ON button to enable the LFO for cutoff frequency modulation.
4-POLE FILTER M/S
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Depth
Strength of the filter frequency modulation by the LFO.

Rate
Adjusts the LFO frequency.

Inv. R Channel Mod 
(invert right channel modulation, only on 4-Pole Filter S)

Inverts the modulation phase of one channel, which leads to some very inter-
esting effects
LFO MODULATION
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RESONATOR M/S
This effect implements a comb filter which is optionally modulated by its own
LFO. The filter is adjustable for frequency, damping and resonance. The LFO
has selectable waveforms, and adjustable depth and rate parameters. This effect
is provided in both mono and stereo versions.

Freq (Frequency)
Sets the basic frequency for the filter. This frequency will be modulated by the
LFO.

Res(Resonance)
Determines the strength of the comb filter effect. The greater the resonance,
the more pronounced the effect.

Damp
Controls the resulting overall tone colour of the filter. Higher values produce
darker, or softer results.

Gain
The Gain control boosts the filtered signal by up to +12 dB.

LFO Wave
Selects the LFO waveform to be used to modulate the filter frequency. The fol-
lowing waveforms are available: Sine, Square, Saw Up, Saw Down, and
Random.

Depth
Sets the strength of the modulation of the adjusted filter frequency by the LFO.
RESONATOR M/S
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Rate
Controls the frequency of the LFO (modulation rate).

Dry
Adjusts the level of the original signal. 

Wet
Adjusts the level of the signal after processing by the resonator effect.
LFO MODULATION
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RING MODULATOR M/S
The Ring Modulator multiplies an audio input signal by an internal sine wave
and outputs the result. If you modulate the sine wave using an LFO, all kinds
of sonic effects evolve, from subtle spectral changes to more obvious electronic
or bell-like effects. The Ring Modulator is supplied in both mono and stereo
versions.

InGain
Adjusts the level (preamplification) of the input signal. It can be boosted by up
to 12 dB.

Sine Freq
Controls the basic frequency of the sine wave oscillator. The range is from 1
Hz, to 4000 Hz.

LFO Wave
Selects the waveform the LFO will use to modulate the sine wave. The fol-
lowing waveforms are available: Sine, Square, Saw Up, Saw Down, and
Random.

Depth
Sets the modulation depth. This controls the amount of deviation from the
basic frequency the sine wave oscillator will produce.

Rate
Controls the rate at which the LFO modulates the sine wave oscillator.

Dry
Adjusts the level of the original signal. 
RING MODULATOR M/S
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Wet
Adjusts the level of the processed signal.
LFO MODULATION
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TREMOLO M/S
The Tremolo effect modulates the amplitude of an input signal periodically
according to the waveshape selected in the Wavefield at a rate set under Rate.
The Depth parameter controls the degree of modulation. This effect is pro-
vided in both mono and stereo versions.

Depth
Controls the depth, or strength of the modulation of the input signal’s ampli-
tude.

Rate
Controls the rate, or speed, of the amplitude modulation.

Wave
Selects the waveform the LFO will use to modulate the amplitude. The fol-
lowing waveforms are available: Sine, Square, Saw Up, Saw Down, and
Random.

Inv. R Channel Mod 
(invert right channel modulation, only on Tremolo S)

Shifts the phase of the right channel of the modulation signal relative to the left
by 180 degrees. The modulation of the right channel follows the left.
TREMOLO M/S
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AUTOPAN
When used with stereo signals, the Autopan effect exchanges the left and right
channels periodically. With a mono signal, the effect operates as a classic pan-
ning effect - the signal sweeps periodically from the left channel to the right and
back. The modulation is controlled by an LFO with settings for Waveform,
Depth, and Rate.

Depth
Controls the depth, or strength of the pan modulation.

Rate
Controls the rate, or speed, of the pan modulation.

Wave
Selects the waveform the LFO will use for pan modulation. The following
waveforms are available: Sine, Square, Saw Up, Saw Down, and Random.
LFO MODULATION
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STEREO PAN
The Stereo Pan effect permits control over the stereo width of a stereo signal.
Since both left and right channels can be positioned anywhere in the full pan
range, it‘s possible, for example, to reverse the stereo image. 

Left
Adjusts the position of the left input channel signal in the stereo output field.

Right
Adjusts the position of the right input channel signal in the stereo output field.

Mono (use left input)
To generate a stereo signal from a mono input signal, connect a signal to the
left input and enable this option. The input signal is then fed proportionately
to both the left and right channels. This mode is enabled when the indicator is
lit.
STEREO PAN
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STEREOEXPANDER
The StereoExpander permits the “breadth” of a stereo image to be increased or
decreased. The processing is mono-compatible and frequency-independent.

Controls

Amount
Adjusts the intensity of the effect. Positive values produce a broadening of the
stereo image, negative values cause it to become narrower.
CONTROLS
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SOFT CLIP M/S
The SoftClip module permits the loudness of a signal to be boosted without
introducing digital overload distortion (hard clipping). Even with signals
which are already at the maximum level, an apparent loudness increase can be
produced. In addition, the sound takes on a warmer, more “analog” character.
Both mono and stereo versions of the effect are provided.

Controls

Drive
Adjusts the intensity of the effect. An orange LED lights when the effect begins
working.

Level
If you wish to alter merely the sound of a signal and not its loudness, you can
use this control to counteract the loudness increase produced by the effect.
SOFT CLIP M/S
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DC FILTER M/S
Removes any existing DC component from a signal. Both mono and stereo
versions of the filter are provided.

Controls

Gain
The DC Filter operates with 6 dB headroom in order to avoid distortion. Typ-
ically, these extra dB can be recovered following DC removal via the amplifier
stage which follows. However, if the peak-indicator LED begins lighting, the
Gain control should be backed off slightly.

Signal Peak
The signal LED (green) indicates all signals above the level of -96dB. The Peak
LED indicates the presence of distortion in the amplifier stage following the
DC filter.
CONTROLS
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Chapter 5 -  FlexiSurface 
Maps

INTRODUCTION

The mapping of plug-in parameters to controls on the control surface is set up
in a FlexiSurface map file. One file exists for each plug-in that has been instan-
tiated or mapped. A default set of maps is supplied for each plug-in supplied
with the Plug-Ins Manager system. The map files are located in the 
C:\Program Files\Fairlight\FMC\Data\Fleximaps directory. Fleximap
filenames end in  .fsm.

The selection of a specific group of faders, or the Parameter Pad for use with
plug-ins is made in the FlexiSurface file:
C:\Program Files\Fairlight\FMC\Data\FlexiSurface.txt. See “FlexiSurface File”
on page 2-31.

Customised maps have been made for all standard plug-ins. If a new plug-in is
added to the system, a map is automatically generated when the plug-in is first
used. This automatic mapping may not suit your requirements for a particular
plug-in. In this case the plug-in’s FlexiSurface map file must be edited using
the Notepad text editor.

To edit the file hold down the Alt key and press the Tab key to switch to the
Windows desktop. Click on the Start menu and select Programs>Acces-
sories>Notepad. File>Open from the Notepad menu and navigate to
C:\Program Files\Fairlight\FMC\Data\Fleximaps\, locate the specific map file
and open it.

FLEXIMAP FILES
Fleximap files offer a sophisticated method of constructing dynamic plug-in
parameter maps for each plug-in.

Each line must start with a command. Commands are followed by a fixed
number of arguments as defined below. Each argument is separated by a
comma. Comments can be included on a separate line and must start with a #.
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The file may contain multiple faderset maps to allow for several pages of
parameters, or to switch maps automatically on parameter changes. This allows
parameters to be displayed in context with the state of a plug-in. For example,
to display delay times in milliseconds or beats-per-minute depending on the
operating mode of a delay plug-in, use the TRIG_PAR command, described
below, linked to the MODE parameter to call the appropriate faderset map. To
provide a button to display a second page of parameters, use the TRIG_SW
command, and define a MORE switch in the faderset map. Each separate map
is marked by a new FADERSET command. Faderset maps are numbered
ascending from 1 as they are read from the top of the file.

The fleximap file also contains a text map section used to translate the normal-
ised parameter values reported by the plug-in system, to actual parameter
values to be displayed in the fader LCD windows or parameter pad LCD. Some
experimentation may be required to obtain a good fit between the values dis-
played on screen and the values displayed on the control surface. The fleximap
system includes functions for converting linear, logarithmic and exponential
display values.

Fleximap Commands
VERSION - file format version.

Arg 1: The version number currently version 1 (DO NOT EDIT).

Usage: VERSION,1

BEGIN_FADERS - marks the beginning of the fader mapping section of the
fleximap. The TRIG_SW, TRIG_PAR commands and FADERSETS under
this section correspond to the FADERS defined in the flexisurface.txt file.

BEGIN_PARAPAD - marks the beginning of the parameter pad mapping sec-
tion of the fleximap. The TRIG_SW, TRIG_PAR commands and FADER-
SETS under this section correspond to the PARAPAD defined in the
flexisurface.txt file.

TRIG_PAR - makes a specific parameter value or range of values a trigger to
call a different faderset map.

Arg 1: The control range minimum (0 to 1). All parameter values are
normalised to a range of 0 to 1. When the parameter value falls
within the range defined, the specified faderset map is dis-
played. For switches, use ranges equal to 1 divided by the
FLEXIMAP FILES
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number of switch positions. For example, the off position of a
toggle switch will be 0 use a range from 0-0.5, the on position
will be 1 use a range from 0.5-1.

 Arg 2: The control range maximum (0 to 1). All parameter values are
normalised to a range of 0 to 1. When the parameter value falls
within the range defined, the specified faderset map is dis-
played.

 Arg 3: The plug-in controller/parameter system name. This is the
system name of the parameter whose value triggers the
TRIG_PAR event. The name is specified in the faderset map
definition described below, the name must be entered exactly
as given in the CONTROL entry.

 Arg 4: The plug-in controller/parameter text output user name (dis-
play name). This is the user name of the parameter whose
value triggers the TRIG_PAR event. This is the name speci-
fied in the faderset map definition described below.

 Arg 5: Faderset map number to be displayed when the plug-in
parameter falls within in the range specified. Faderset maps are
numbered ascending from 1 as they are read from the top of
the file.

Usage: TRIG_PAR,0,0.5,DSP-Delay LM:Mode,mS/BPM,1

FADERSET - marks the beginning of a new faderset map. Faderset maps are
numbered ascending from 1 as they are read from the top of
the file. Each faderset map includes a list of CONTROL com-
mands as described below.

CONTROL - each parameter to be mapped to a physical control is defined
with a separate CONTROL command.

 Arg 1: The FlexiSurface control type to be used to control the param-
eter. Valid arguments are:
Fader panel controls - FS_FADER, FS_PAN, FS_MUTE 
Parameter Pad controls - PP_ENC, PP_SW

 Arg 2: The FlexiSurface control index, i.e. faderstrip number or
Parameter Pad control number. Index value starts from 1. The
number of faderstrips available (i.e. maximum control index)
is defined in the FlexiSurface file. See “FlexiSurface File” on
FLEXIMAP COMMANDS
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page 2-31 for more details. Parameter pad encoders and
switches are number from 1 to 10, top to bottom, left to right.

 Arg 3: The minimum control range (0 to 1). All parameter values are
normalised to a range of 0 to 1. Use this argument to limit the
control range to suit a particular plug-in parameter.

Arg 4: The maximum control range (0 to 1). All parameter values are
normalised to a range of 0 to 1. Use this argument to limit the
control range to suit a particular plug-in parameter.

Arg 5: The plug-in controller transfer function. Valid arguments are:
LIN, LOG, ANTILOG. Use LIN to provide linear control of
linear parameters such as percentage or switch functions, LOG
applies a logarithmic control curve for logarithmic parameters
such as gain or pitch, ANTILOG applies an inverse logarithmic
control curve for parameters such as frequency. These argu-
ments are provided to allow the best fit between encoder or
fader resolution and the parameter range being controlled.
Some experimentation may be required to select the appro-
priate transfer function.

Arg 6: The plug-in controller system name (DO NOT EDIT). This
name is automatically generated when the plug-in is first
instantiated.

Arg 7: The plug-in controller user name (display name). Use this
argument to provide a user-friendly name to be displayed in
the LCD window. User names are limited to 8 characters in
length.

Usage: CONTROL,PP_ENC,7,0,1,ANTILOG,DSP-Delay LM:Wet,Wet

TRIG_SW - makes a switch a trigger to call a different faderset map. The
TRIG_SW command must appear in the faderset in which it
is displayed.

Arg 1: The FlexiSurface control type. Valid arguments are:
Fader panel controls - FS_FADER, FS_PAN, FS_MUTE 
Parameter Pad controls - PP_ENC, PP_SW

Arg 2: The FlexiSurface control index, i.e. fader number or param-
eter pad control number, starting from 1.
FLEXIMAP FILES
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Arg 3: The plug-in controller user name (display name). For
example, use NEXT or MORE to indicate the selection of a
second page of parameters.

Arg 4: Faderset map number to be displayed when switch is pressed.
Faderset maps are numbered ascending from 1 as they are read
from the top of the file.

Usage: TRIG_SW,FS_MUTE,1,More,2

BEGIN_TEXTMAP - marks the beginning of the textmap section of the flex-
imap. This section is used to convert the normalised parameter
values, reported by the plug-in, to human readable values with
or without units. The human readable values are displayed in
the LCD window on a fader strip or in the parameter pad
LCD. The textmap section always appears at the end of the
fleximap file. The text mapping features include scaling, off-
sets, linear and log transfer functions, prefix and postfix text
items. An example of the transfer function of a parameter
between the software parameter (which is always between 0
and 1) and the output is shown below.

BEGIN_PARAMETER - marks the beginning of a parameter definition within
the text map section. 

Arg 1: The system name of the parameter being mapped. The param-
eter name must appear exactly as displayed in the parameter
system name field in the faderset map described above. Param-
eter system names include the plug-in system type, plug-in
name and parameter name separated by a colon as shown
below.

Usage: BEGIN_PARAMETER,DSP-Delay LM:Gain
FLEXIMAP COMMANDS
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BEGIN_SEGMENT - marks the beginning of a segment. A segment is a linear
portion of the map between the software representation of a
value (from 0 to 1) to the value seen by the end user. In the
diagram above, there are three segments (AB, BC, CD). A
maximum of 32 segments can be used for each parameter. Use
segments for multi-position switches or to obtain a more accu-
rate representation of parameter values with irregular transfer
functions.

Each segment can have the following keywords: RANGE,
PREFIX, POSTFIX, LOG, SCALE, OFFSET, DIVISOR,
DECIMAL_PLACES, POSTFIXONLY.

Usage: BEGIN_SEGMENT

RANGE - The range is the software parameter value range that a segment
is valid for. In the diagram above, the AB segment has a range
of 0 to 0.25.

Usage: RANGE,0,0.25

PREFIX - This is text placed in front of the output value that is displayed
on a control. If omitted, no prefix is included.

Usage: PREFIX,Mode
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POSTFIX - This is text placed after the output value that is displayed on a
control. If omitted, no postfix is included.

Usage: POSTFIX,dB

LOG - This flag is included to support older fsm files. New maps
should use the LOG2, EXP or EXP2 flag. The LOG flag indi-
cates whether the segment is a straight line segment or a log to
the base 10 segment. If the segment is a straight line, then the
scale and offset values need to be defined. If the segment is a
log, then the scale and divisor values need to be defined. The
LOG command must appear before the SCALE and
DIVISOR commands. LOG segments fit the following for-
mula: 
y = SCALE * 10(x / DIVISOR). For more information on
defining segments with straight lines or logarithmic lines, see
the information on segments below.

Usage: LOG

LOG2 - The LOG2 flag returns segment display values derived from
the logarithm of the normalised control values. When using
LOG2, the OFFSET, SCALE, DIVISOR and OFFSET2
arguments must also be defined. LOG2 segments fit the fol-
lowing formula:
y=OFFSET+SCALE * log10

x/DIVISOR+OFFSET2

For more information on defining segments with straight lines
or logarithmic lines, see the information on segments below.

EXP - The EXP flag returns segment display values derived from the
normalised control values via an exponential formula. When
using EXP, the OFFSET, SCALE, DIVISOR and OFFSET2
arguments must also be defined. EXP segments fit the fol-
lowing formula:
y=OFFSET+SCALE * 10x/DIVISOR+OFFSET2

For more information on defining segments with straight lines
or logarithmic lines, see the information on segments below.

EXP2 - The EXP2 flag returns segment display values derived from
the normalised control values via an exponential formula.
When using EXP2, the OFFSET, SCALE, DIVISOR and
OFFSET2 arguments must also be defined. EXP2 segments
FLEXIMAP COMMANDS
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fit the following formula:
y=OFFSET+SCALE/(OFFSET2+10x/DIVISOR)
For more information on defining segments with straight lines
or logarithmic lines, see the information on segments below.

SCALE - This is the gradient of a straight line segment or the multiplier
in a logarithmic or exponential segment. For a straight line,
the formula y = Ax + B represents the line, where A is the
SCALE.

Usage: SCALE,99

OFFSET - This is the y-intercept of a straight line segment or an offset in
a logarithmic or exponential segment. For a straight line, the
formula y = Ax + B represents the line, where B is the
OFFSET.

Usage: OFFSET,-99

OFFSET2 - This is an internal offset used to derive logarithmic or expo-
nential curves. For more information on defining segments
with exponential or logarithmic curves, see the information on
segments below.

Usage: OFFSET2,0.001032

DIVISOR - This the divisor in a logarithmic or exponential segment. For
more information on defining segments with exponential or
logarithmic curves, see the information on segments below.

Usage: DIVISOR,15

DECIMAL_PLACES - Specifies the resolution of the display shown to the user
for the segment of the parameter being defined.

Usage: DECIMAL_PLACES,1

POSTFIXONLY - Specifies whether the user will see a numerical value as cal-
culated for the segment or the user will just see the POSTFIX
value.

Usage: POSTFIXONLY
FLEXIMAP FILES
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Example Map File
This map provides two faderset maps. When the MODE parameter has a value
of 0, the first faderset map is displayed showing delay values in milliseconds.
When the MODE switch is pressed the MODE parameter is set to 1 causing the
second faderset map to be displayed showing beats-per-minute.

# PULSAR-Delay LM.FSM
#Version number - must be 1
VERSION,1
BEGIN_FADERS
#Two trigger events to call the fader sets
TRIG_PAR,0,0.5,DSP-Delay LM:Mode,text,1
TRIG_PAR,0.5,1,DSP-Delay LM:Mode,text,2
#Fader set number 1 definition
FADERSET
CONTROL,FS_MUTE,1,0,1,LIN,DSP-Delay LM:Bypass,Bypass
CONTROL,FS_MUTE,2,0,1,LIN,DSP-Delay LM:Mode,ms/BPM
CONTROL,FS_FADER,1,0,1,ANTILOG,DSP-Delay LM:Delay,Delay
CONTROL,FS_FADER,3,0,1,LIN,DSP-Delay LM:FB,FB
CONTROL,FS_FADER,4,0,1,ANTILOG,DSP-Delay LM:LDmp,LDmp
CONTROL,FS_FADER,5,0,1,ANTILOG,DSP-Delay LM:HDmp,HDmp
CONTROL,FS_FADER,6,0,1,ANTILOG,DSP-Delay LM:Dry,Dry
CONTROL,FS_FADER,7,0,1,ANTILOG,DSP-Delay LM:Wet,Wet
#Fader set number 2 definition
FADERSET
CONTROL,FS_MUTE,1,0,1,LIN,DSP-Delay LM:Bypass,Bypass
CONTROL,FS_MUTE,2,0,1,LIN,DSP-Delay LM:Mode,ms/BPM
CONTROL,FS_FADER,1,0,1,LIN,DSP-Delay LM:BPM,BPM
CONTROL,FS_FADER,2,0,1,LIN,DSP-Delay LM:Note,Note
CONTROL,FS_FADER,3,0,1,LIN,DSP-Delay LM:FB,FB
CONTROL,FS_FADER,4,0,1,ANTILOG,DSP-Delay LM:LDmp,LDmp
CONTROL,FS_FADER,5,0,1,ANTILOG,DSP-Delay LM:HDmp,HDmp
CONTROL,FS_FADER,6,0,1,ANTILOG,DSP-Delay LM:Dry,Dry
CONTROL,FS_FADER,7,0,1,ANTILOG,DSP-Delay LM:Wet,Wet
BEGIN_PARAPAD
#Two trigger events to call the fader sets
TRIG_PAR,0,0.5,DSP-Delay LM:Mode,text,1
TRIG_PAR,0.5,1,DSP-Delay LM:Mode,text,2
#Parapad set number 1 definition
FADERSET
CONTROL,PP_SW,1,0,1,LIN,DSP-Delay LM:Bypass,Bypass
CONTROL,PP_SW,2,0,1,LIN,DSP-Delay LM:Mode,ms/BPM
CONTROL,PP_ENC,1,0,1,ANTILOG,DSP-Delay LM:Delay,Delay
EXAMPLE MAP FILE
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CONTROL,PP_ENC,3,0,1,LIN,DSP-Delay LM:FB,FB
CONTROL,PP_ENC,4,0,1,ANTILOG,DSP-Delay LM:LDmp,LDmp
CONTROL,PP_ENC,5,0,1,ANTILOG,DSP-Delay LM:HDmp,HDmp
CONTROL,PP_ENC,6,0,1,ANTILOG,DSP-Delay LM:Dry,Dry
CONTROL,PP_ENC,7,0,1,ANTILOG,DSP-Delay LM:Wet,Wet
#Parapad set number 2 definition
FADERSET
CONTROL,PP_SW,1,0,1,LIN,DSP-Delay LM:Bypass,Bypass
CONTROL,PP_SW,2,0,1,LIN,DSP-Delay LM:Mode,ms/BPM
CONTROL,PP_ENC,1,0,1,LIN,DSP-Delay LM:BPM,BPM
CONTROL,PP_ENC,2,0,1,LIN,DSP-Delay LM:Note,Note
CONTROL,PP_ENC,3,0,1,LIN,DSP-Delay LM:FB,FB
CONTROL,PP_ENC,4,0,1,ANTILOG,DSP-Delay LM:LDmp,LDmp
CONTROL,PP_ENC,5,0,1,ANTILOG,DSP-Delay LM:HDmp,HDmp
CONTROL,PP_ENC,6,0,1,ANTILOG,DSP-Delay LM:Dry,Dry
CONTROL,PP_ENC,7,0,1,ANTILOG,DSP-Delay LM:Wet,Wet
BEGIN_TEXTMAP
#Parameter value text map section
BEGIN_PARAMETER,DSP-Delay LM:Delay
#scale to show correct delay values

BEGIN_SEGMENT
RANGE,0,1
POSTFIX,mS
SCALE,5136

BEGIN_PARAMETER,DSP-Delay LM:Mode
#display mS/BPM mode switch values

BEGIN_SEGMENT
RANGE,0,0.5
POSTFIXONLY
POSTFIX,mS

BEGIN_SEGMENT
RANGE,0.5,1
POSTFIXONLY
POSTFIX,BPM

Segment Mapping
When a parameter is mapped to a control such as plug-in gain assigned to a
fader, the user will see text on both the onscreen plug-in display and the LCD
window to indicate the current value of the parameter. This value will be dis-
played in dB for gain or the appropriate units for the parameter. Since all
parameters in the plug-in system are internally stored as values between 0 and
FLEXIMAP FILES
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1, there needs to be a conversion process to correctly display the values on the
control surface. This is achieved using a set of segment mapping functions.

The map for a particular parameter can be split up into a number of segments
if required. Each segment can be a straight line relationship a logarithmic or
exponential relationship to the normalised internal value. 

The process of correctly mapping display values for segments requires the use
of the MSAT application to read the normalised parameter values transmitted
by FMC. For Log or Exponential control curves an automated spreadsheet is
available to calculate the SCALE, DIVISOR and OFFSET values required.
Follow the steps below:

1. Use the LIN, LOG or ANTILOG arguments in the CONTROL section to 
match the travel of the control surface control to the on-screen plug-in 
control. i.e. make the halfway point of the controls coincide as near as 
possible.

2. Determine if control is linear. i.e. is the half way point equal to half the 
range of parameter values. If linear, the OFFSET = the lowest parameter 
value, and the SCALE = maximum parameter value - OFFSET.

3. Determine if the control is a multi-position switch e.g. text values. If so 
determine the control value range of each switch and divide textmap into 
segments as shown below.

4. If the control is not linear, copy 10 displayed parameter values from the 
plug-in screen at normalised MSAT control values of 0, 100, 200, ... 
1000.

5. Load these values into the curve fitting spreadsheet to determine the cor-
rect DIVISOR, SCALE, OFFSET and OFFSET2 values to add to the 
text map.

The following examples show how parameters can be mapped.

#EXAMPLE 1
#LOG2 LEVEL PARAMETER FOR A DISTORTION PLUG-IN
BEGIN_PARAMETER,DSP-Distortion:LEVEL

BEGIN_ SEGMENT
RANGE,0,1
LOG2
DIVISOR,1
SCALE,20.244
OFFSET,-0.0636
OFFSET2,0.00109
SEGMENT MAPPING
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DECIMALPLACES,2

The displayed estimate value is calculated using the formula
 y=OFFSET+SCALE * log10

x/DIVISOR+OFFSET2

The resulting displayed values closely match the values displayed in the on-
screen plug-in display.

A useful spreadsheet is available from Fairlight which automates the selection
of curve types and the calculation of parameters.

#EXAMPLE 2
#5 POSITION WAVE SHAPE SELECTION
BEGIN_PARAMETER,DSP-Ring Modulator:WaveShape

BEGIN_ SEGMENT
RANGE,0,0.2
POSTFIXONLY
POSTFIX,SINE

BEGIN_ SEGMENT
RANGE,0.2,0.4
POSTFIXONLY
POSTFIX,SQUARE

BEGIN_ SEGMENT
RANGE,0.4,0.6
POSTFIXONLY
POSTFIX,TRIANGLE

BEGIN_ SEGMENT
RANGE,0.6,0.8
POSTFIXONLY
POSTFIX,SAW

BEGIN_ SEGMENT
RANGE,0.8,1
POSTFIXONLY
POSTFIX,NOISE

This example shows how a five position switch can be mapped to display text
values for the five discrete positions. Some experimentation may be required to
find the correct threshold values for the switch positions.
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Chapter 6 -  Specif ications

CONNECTIONS

Digital I/O Connector
Description: 16 balanced pairs AES/EBU digital audio.

Note - to connect to a standard QDC 50 pin digital I/O connector, wire cable
pin 1 to pin 1, pin 2 to pin 2, and so on.

Connector: 50 pin D female

+ GND - Channel #

17 33 50 Digital Output 1/2
16 32 49 Digital Output 3/4
15 31 48 Digital Output 5/6
14 30 47 Digital Output 7/8
13 29 46 Digital Input 1/2
12 28 45 Digital Input 3/4
11 27 44 Digital Input 5/6
10 26 43 Digital Input 7/8
9 25 42 Digital Output 9/10
8 24 41 Digital Output 11/12
7 23 40 Digital Output 13/14
6 22 39 Digital Output 15/16
5 21 38 Digital Input 9/10
4 20 37 Digital Input 11/12
3 19 36 Digital Input 13/14
2 18 35 Digital Input 15/16
DIGITAL I/O CONNECTOR
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APIM102-D
Description: DC and USB connection for SSM installation of AIB card.

Note - USB connections may vary on some motherboards.

Connectors: 

CN1 - 6-pin Molex 39-01-2060 (Farnell 151-868) with Crimp Pins 39-00-
0039 (Farnell 151-890).

CN2 - 5-pin FCI 65039-032 (Farnell 528-481) with Crimp Pins FCI 47750-
00 (Farnell 528-560).

CN3 - 4-pin AMP 1-480426-0 (Farnell 299-479) with Crimp Pins AMP
163305-2 (Farnell 299-558)

CN1 Signal Wire CN2 CN3

1 USBD+ L-2B2AT Orange 3 NC
2 GND Braid 4 NC
3 Spare Brown 5 NC
4 USBD- L-2B2AT white 2 NC
5 GND Black NC 3
6 Vcc Red NC 4

CN2 pin 1 not connected
CN3 pin 1,2 not connected
CONNECTIONS
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ABE1205-A
Description: DC and USB connection from SBO card to AIB card in Station
and Console.

Connectors: 6-pin Molex 39-01-2060 (Farnell 151-868) with Crimp Pins 39-
00-0039 (Farnell 151-890).

CN1 Signal Wire CN2

1 USBD+ L-2B2AT Orange 1
2 GND Braid 2
3 Spare NC 3
4 USBD- L-2B2AT white 4
5 GND Black 5
6 Vcc Red 6
ABE1205-A
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